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Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide 

 

Cisco is bringing a new standard to desk phones with a portfolio built for working in modern office environments. 
The Desk Phone 9800 Series was designed with IT and facilities in mind to deliver 4 new phone models. Included 
on each phone is the newly released PhoneOS software that simplifies the user experience and compliments our 
video portfolios RoomOS devices to give a seamless experience from desk spaces to meeting rooms. With 
expanded functionality – the 9800 Series combines secure enterprise calling, meetings, desk reservations, 
sustainability, emergency alerts and calling all in one device. You don’t need to buy a dedicated device for each 
feature – all the features are built into each phone. 

The Desk Phone 9800 Series reduces the complexity of purchasing, deploying, managing, and training. To further 
simplify, you can use one device for Cisco Unified Communications Manager (CUCM), Webex Calling, 
Broadworks, or other 3rd party cloud calling platforms. Alongside our extensive portfolio of desk devices, the 9800 
series is uniquely positioned in the market to help transform the workplace by bridging the gap between hybrid 
work, calling, and meetings – and is the most cost-effective solution for workstations at scale. 

 

This guide provides information and guidance to help the network administrator deploy the 9800 Series into a 
wireless LAN environment. 
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Cisco Desk Phone 9800 Series Overview 

Cisco’s implementation of 802.11 permits time sensitive applications such as call and voice to operate efficiently across 
campus wide over wireless LAN (WLAN) deployments. These extensions provide fast roaming capabilities and almost 
seamless flow of multimedia traffic, whilst maintaining security as the end user roams between access points. 
WLAN uses unlicensed spectrum, and as a result it may experience interference from other devices using the unlicensed 
spectrum. The proliferation of devices in the 2.4 GHz spectrum, such as Bluetooth headsets, Microwave ovens, cordless 
consumer phones, means that the 2.4 GHz spectrum may contain more congestion than other spectrums.  The 5 GHz spectrum 
has far fewer devices operating in this spectrum and is the preferred spectrum to operate the Cisco Desk Phone 9800 Series to 
take advantage of the 802.11a/n data rates available.   

Despite the optimizations that Cisco has implemented in the Cisco Desk Phone Series, the use of unlicensed spectrum means 
that uninterrupted communication cannot be guaranteed, and there may be the possibility of voice gaps of up to several 
seconds during conversations. Adherence to these deployment guidelines will reduce the likelihood of these voice gaps being 
present, but there is always this possibility.  

Using unlicensed spectrum, and the inability to guarantee the delivery of messages to a WLAN device, the Cisco Desk Phone 
9800 Series is not intended to be used as a medical device and should not be used to make clinical decisions. 

Models 

The following table shows available phone models with WLAN capability. 

Below outlines the peak antenna gain and frequency ranges/channels supported by each model. 

Part Number Description Peak Antenna Gain Frequency Ranges Available 
Channels 

Channel Set 

DP-9871-K9= 
DP-9871-L-K9= 
DP-9871-K9++= 
DP-9871-K9--= 

Cisco Desk 
Phone 9871 

2.400-2.483GHz: 3.22 dBi 

5.150-5.250GHz: 3.60 dBi 

5.250-5.350GHz: 3.62 dBi 

5.470-5.725GHz: 4.23 dBi 

5.725-5.850GHz: 4.13 dBi 

2.412 - 2.472 GHz 

5.180 - 5.240 GHz  

5.260 - 5.320 GHz 

5.500 - 5.700 GHz  

5.745 - 5.825 GHz 

13 

4 

4 

11 

5 

1-13 

36,40,44,48 

52,56,60,64 

100-144 

149,153,157,161,165 

DP-9861-K9= 
DP-9861-L-K9= 
DP-9861-K9++= 
DP-9861-K9--= 

Cisco Desk 
Phone 9861 

2.400-2.483GHz: 3.06 dBi 

5.150-5.250GHz: 3.98 dBi 

5.250-5.350GHz: 4.07 dBi 

5.470-5.725GHz: 4.11 dBi 

5.725-5.850GHz: 3.76 dBi 

2.412 - 2.472 GHz 

5.180 - 5.240 GHz  

5.260 - 5.320 GHz 

5.500 - 5.700 GHz  

5.745 - 5.825 GHz 

13 

4 

4 

11 

5 

1-13 

36,40,44,48 

52,56,60,64 

100-144 

149,153,157,161,165 

Requirements 

The Cisco Desk Phone 9800 Series units are IEEE 802.11a/b/g/n/ac collaboration device that provide voice and data 
communications. The wireless LAN must be validated to ensure it meets the requirements to deploy the Cisco Desk Phone 
Series. 

Site Requirement 
Before deploying the Cisco Desk Phone 9800 Series into a production environment, a site survey must be completed by a 
Cisco certified partner with the advanced wireless LAN specialization. During the site survey, the RF spectrum can be 
analyzed to determine which channels are unable in the desired band (5GHz or 2.4GHz).  Typically, there is less interference 
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in the 5GHz band as well as more non-overlapping channels, so 5GHz is the preferred band for operation and even more 
highly recommended when the Cisco Desk Phone 9800 Series units are to be used in a mission critical environment.  The site 
survey will include heatmaps showing the intended coverage plan for the location.   The site survey will also determine which 
access point platform type, antenna type, access point configuration (channel and transmit power) to use at the location.  It is 
recommended to select an access point with integrated antennas for non-rugged environments (e.g. office, healthcare, 
education, hospitality) and an access point platform requiring external antennas for rugged environments (e.g. manufacturing, 
warehouse, retail).  
The wireless LAN must be validated to ensure it meets the requirements to deploy the Cisco Desk Phone 9800 Series. 

Signal 

The cell edge should be designed to -67 dBm where there is a 20-30% overlap of adjacent access point at that signal 
level. 

This ensures that the Cisco Desk Phone 9800 Series always has adequate signal and can hold a signal long enough to 
roam seamlessly where signal-based triggers are utilized vs. packet loss triggers.   

Also need to ensure that the upstream signal from the phone meets the access point's receiver sensitivity for the 
transmitted data rate.  Rule of thumb is to ensure that the received signal at the access point is -67 dBm or higher. 

It is recommended to design the cell size to ensure that the phone can hold a signal for at least 5s. 

Channel Utilization 

Channel Utilization levels should be kept under 40%. 

Noise 

Noise levels should not exceed -92 dBm, which allows for a Signal to Noise Ratio (SNR) of 25 dB where a -67 dBm 
signal should be maintained.  

Also need to ensure that the upstream signal from the Cisco Desk Phone 9800 Series meets the access point’s signal to 
noise ratio for the transmitted data rate.   

Packet Loss / Delay 

Per voice guidelines, packet loss should not exceed 1% packet loss. Otherwise, voice quality can be degraded 
significantly. 

Jitter should be kept at a minimal (< 100 ms). 

Retries 

802.11 retransmissions should be less than 20%.  

Multipath 

Multipath should be kept to a minimal as this can create nulls and reduce signal levels. 

Call Control 
The Cisco Desk Phone 9800 Series is supported on the following call control platforms. 

• Cisco Webex Calling 
• Cisco Unified Communications Manager (CUCM) (12.5 or above) 
• Webex Dedicated Instance (DI) 
• Cisco BroadWorks 

Note: Cisco Unified Communications Manager requires a device package to be installed or service release update in order 
to enable Cisco Desk Phone 9800 Series device support. 

Device packages for Cisco Desk Phone 9800 Series are available at the following location. 
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https://software.cisco.com/download/home/286322286/type/282074299/release/12.5(1.19210) 

https://software.cisco.com/download/home/286328117/type/282074299/release/14.0(1.14056) 

https://software.cisco.com/download/home/286331940/type/282074299/release/15.0(1.12004) 

Wireless LAN 
The Cisco Desk Phone 9800 Series is supported on the following Cisco Wireless LAN solutions. 

• Cisco AireOS Wireless LAN Controller and Cisco Lightweight Access Points 
o Minimum = 8.10.185.0 
o Recommended = 8.10.190.0, 8.10.196.0 

• Cisco IOS Wireless LAN Controller and Cisco Lightweight Access Points 
o Minimum = 17.3.5 
o Recommended = 17.9.5, 17.6.6, 17.12.1 

• Cisco Mobility Express and Cisco Lightweight Access Points 
o Minimum = 8.10.105.0 
o Recommended = 8.10.105.0, 8.10.130.0, 8.10.142.0, 8.10.196.0  

• Cisco Autonomous Access Points 
o Minimum = 15.3(3)JPK2 
o Recommended = 15.3(3)JPK2, 15.3(3)JPK3, 15.3(3)JPK4, 15.3(3)JPK6 

• Cisco Meraki Access Points 
o Minimum = MR 27.X, MX 13.33 
o Recommended = MR 30.6, MX 18.211.2 

Access Points 

See the following table for the Cisco access points that are supported. 

Controller 
Model  

AP Models 

AireOS 1700, 1810, 1810W, 1815, 1830, 1840, 1850, 2700, 2800, 3700, 3800, 4800, 9105, 9115, 9117, 9120, 
9130 

IOS XE 1700, 1810, 1810W, 1815, 1830, 1840, 1850, 2700, 2800, 3700, 3800, 4800, 9105, 9115, 9117, 9120, 
9130, 9136, 9162, 9164, 9166 

Mobility 
Express 

1815 (not 1815t), 1830, 1840, 1850, 2800, 3800, 4800 

Autonomous 1700, 2700, 3700 

Meraki 9162, 9164, 9166, MR20, MR28, MR30H, MR32, MR33, MR34, MR36, MR36H, MR42, MR44, MR45, 
MR46, MR52, MR53, MR55, MR56, MR57, MX64W, MX65W, MX67W, MX68W, Z3 

 

  

https://software.cisco.com/download/home/286322286/type/282074299/release/12.5(1.19210)
https://software.cisco.com/download/home/286328117/type/282074299/release/14.0(1.14056)
https://software.cisco.com/download/home/286331940/type/282074299/release/15.0(1.12004)
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Antenna System 

Some Cisco access points require or allow external antennas. 

Please refer to the following URL for the list of supported antennas for Cisco Aironet access points and how the external 
antennas should be mounted. 

https://www.cisco.com/c/en/us/products/collateral/wireless/aironet-antennasaccessories/ 
product_data_sheet09186a008008883b.html 

Note: Cisco access points with integrated internal antennas (other than models intended to be wall mounted) are to be mounted 
on the ceiling as they have omni-directional antennas and are not designed to be wall mounted. 

Protocols 

Supported wireless LAN protocols include the following: 

• 802.11a,b,d,e,g,h,i,n,ac 

• Wi-Fi MultiMedia (WMM)  

• Session Initiation Protocol (SIP) 

• Real Time Protocol (RTP) 

• Opus, G.722, G.711, G.722.1, G.729 

• Dynamic Host Configuration Protocol (DHCP) 

• Trivial File Transfer Protocol (TFTP) 

• HyperText Transfer Protocol (HTTP) 

Wi-Fi 

Cisco Desk Phone 9800 Series can work with 2.4GHz (HT20) or 5GHz (HT20/HT40/VHT20/VHT40/VHT80) mode.   To 
achieve 802.11n/ac connectivity, it is recommended that the Cisco Desk Phone 9800 Series be within 30 feet of the access 
point. 

5 GHz Specifications 
5 GHz - 802.11a Data Rate Spatial Streams Modulation 

Max Tx Power=18 dBm 

(Depends on region) 

6 Mbps 

9 Mbps 

12 Mbps 

18 Mbps 

24 Mbps 

36 Mbps 

48 Mbps 

54 Mbps 

1 

1 

1 

1 

1 

1 

1 

1 

OFDM-BPSK 

OFDM-BPSK 

OFDM-QPSK 

OFDM-QPSK 

OFDM-16QAM 

OFDM-16QAM 

OFDM-64QAM 

OFDM-64QAM 

5 GHz-802.11n (HT20) Date Rate Spatial Streams Modulation 

Max Tx Power=18 dBm 

(Depends on region) 

7 Mbps (MCS 0) 

14 Mbps (MCS 1) 

21 Mbps (MCS 2) 

1 

1 

1 

OFDM-BPSK 

OFDM-QPSK 

OFDM-QPSK 
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29 Mbps (MCS 3) 

43 Mbps (MCS 4) 

58 Mbps (MCS 5) 

65 Mbps (MCS 6) 

72 Mbps (MCS 7) 

1 

1 

1 

1 

1 

OFDM-16QAM 

OFDM-16QAM 

OFDM-64QAM 

OFDM-64QAM 

OFDM-64QAM 

5 GHz-802.11n (HT40) Date Rate Spatial Streams Modulation 

Max Tx Power=17 dBm 

(Depends on region) 

15 Mbps (MCS 0) 

30 Mbps (MCS 1) 

45 Mbps (MCS 2) 

60 Mbps (MCS 3) 

90 Mbps (MCS 4) 

120 Mbps (MCS 5) 

135 Mbps (MCS 6) 

150 Mbps (MCS 7) 

1 

1 

1 

1 

1 

1 

1 

1 

OFDM-BPSK 

OFDM-QPSK 

OFDM-QPSK 

OFDM-16QAM 

OFDM-16QAM 

OFDM-64QAM 

OFDM-64QAM 

OFDM-64QAM 

5 GHz-802.11ac (VHT20) Date Rate Spatial Streams Modulation 

Max Tx Power=18 dBm 

(Depends on region) 

7 Mbps (MCS 0) 

14 Mbps (MCS 1) 

21 Mbps (MCS 2) 

29 Mbps (MCS 3) 

43 Mbps (MCS 4) 

58 Mbps (MCS 5) 

65 Mbps (MCS 6) 

72 Mbps (MCS 7) 

87 Mbps (MCS 8) 

1 

1 

1 

1 

1 

1 

1 

1 

1 

OFDM-BPSK 

OFDM-QPSK 

OFDM-QPSK 

OFDM-16QAM 

OFDM-16QAM 

OFDM-64QAM 

OFDM-64QAM 

OFDM-64QAM 

OFDM-256QAM 

5 GHz-802.11ac (VHT40) Date Rate Spatial Streams Modulation 

Max Tx Power=17 dBm 

(Depends on region) 

15 Mbps (MCS 0) 

30 Mbps (MCS 1) 

45 Mbps (MCS 2) 

60 Mbps (MCS 3) 

90 Mbps (MCS 4) 

120 Mbps (MCS 5) 

135 Mbps (MCS 6) 

150 Mbps (MCS 7) 

180 Mbps (MCS 8) 

200 Mbps (MCS 9) 

1 

1 

1 

1 

1 

1 

1 

1 

1 

1 

OFDM-BPSK 

OFDM-QPSK 

OFDM-QPSK 

OFDM-16QAM 

OFDM-16QAM 

OFDM-64QAM 

OFDM-64QAM 

OFDM-64QAM 

OFDM-256QAM 

OFDM-256QAM 

5 GHz-802.11ac (VHT80) Date Rate Spatial Streams Modulation 

Max Tx Power=15 dBm 33 Mbps (MCS 0) 1 OFDM-BPSK 
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(Depends on region) 65 Mbps (MCS 1) 

98 Mbps (MCS 2) 

130 Mbps (MCS 3) 

195 Mbps (MCS 4) 

260 Mbps (MCS 5) 

293 Mbps (MCS 6) 

325 Mbps (MCS 7) 

390 Mbps (MCS 8) 

433 Mbps (MCS 9) 

1 

1 

1 

1 

1 

1 

1 

1 

1 

OFDM-QPSK 

OFDM-QPSK 

OFDM-16QAM 

OFDM-16QAM 

OFDM-64QAM 

OFDM-64QAM 

OFDM-64QAM 

OFDM-256QAM 

OFDM-256QAM 

 

2.4 GHz Specifications 
2.4 GHz - 802.11b Data Rate Spatial Streams Modulation 

Max Tx Power=18 dBm 

(Depends on region) 

1 Mbps 

2 Mbps 

5.5 Mbps 

11 Mbps 

1 

1 

1 

1 

DSSS-BPSK 

DSSS-QPSK 

DSSS-CCK 

DSSS-CCK 

2.4 GHz - 802.11g Data Rate Spatial Streams Modulation 

Max Tx Power=18 dBm 

(Depends on region) 

6 Mbps 

9 Mbps 

12 Mbps 

18 Mbps 

24 Mbps 

36 Mbps 

48 Mbps 

54 Mbps 

1 

1 

1 

1 

1 

1 

1 

1 

OFDM-BPSK 

OFDM-BPSK 

OFDM-QPSK 

OFDM-QPSK 

OFDM-16QAM 

OFDM-16QAM 

OFDM-64QAM 

OFDM-64QAM 

2.4 GHz - 802.11n (HT20) Data Rate Spatial Streams Modulation 

Max Tx Power=16 dBm 

(Depends on region) 

7 Mbps 

14 Mbps 

21 Mbps 

29 Mbps 

43 Mbps 

58 Mbps 

65 Mbps 

72 Mbps 

1 

1 

1 

1 

1 

1 

1 

1 

OFDM-BPSK 

OFDM-BPSK 

OFDM-QPSK 

OFDM-QPSK 

OFDM-16QAM 

OFDM-16QAM 

OFDM-64QAM 

OFDM-64QAM 

Note: Tx power includes antenna gain. 
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Regulatory 
World Mode (802.11d) allows a client to be used in different regions, where the client can adapt to using the channels and 
transmit powers advertised by the access point in the local environment. 

The Cisco Desk Phone 9800 Series operates best with an access point that has 802.11d enabled, where it can determine the 
channels and transmit powers to use per the local region. 

Enable World Mode (802.11d) for the corresponding country where the access point is located. 

Some 5 GHz channels are also used by radar technology, which requires that the 802.11 client and access point to be 802.11h 
compliant to utilize those radar frequencies (DFS channels).  802.11h requires 802.11d to be enabled. 

The Cisco Desk Phone 9800 Series will passively scan DFS channels first before engaging in active scans for those channels. 

If 802.11d is not enabled, then the Cisco Desk Phone 9800 Series will attempt to connect to the access point using reduced 
transmit power. 

Cisco Desk Phone 9800 Series supports county codes which follow WFA definition. 

Bluetooth 

The Cisco Desk Phone 9800 Series supports Bluetooth technology allowing for wireless headset communications. 
Bluetooth enables low bandwidth wireless connections within a range of 30 feet. However, it is recommended to keep the 
Bluetooth device within 10 feet of the Cisco Desk Phone 9800 Series. 
The Bluetooth device does not need to be within direct line-of-sight of the phone, but barriers such as walls, doors, etc. can 
potentially impact the quality. 
Bluetooth operates on the 2.4 GHz frequency, similar to 802.11b/g/n and various other devices (e.g., microwave ovens, 
cordless phones, etc.). Therefore, Bluetooth quality may be affected by potential interference from other devices using this 
unlicensed frequency. 

Bluetooth Profiles 
The Cisco Desk Phone 9800 Series supports the following Bluetooth profiles. 

• Advanced Audio Distribution Profile (A2DP) 
• Audio/Video Remote Control Profile (AVRCP) 
• Generic Access Profile (GAP) 
• Generic Audio/Video Distribution Profile (GAVDP) 
• Hands-Free Profile (HFP) 

Coexistence (802.11b/g/n + Bluetooth) 
If using Coexistence where 802.11b/g/n and Bluetooth are used simultaneously, it is important to consider the 
following limitations and deployment requirements because they both utilize the 2.4 GHz frequency range. 

Capacity 
When using Coexistence (802.11b/g/n + Bluetooth), call capacity is reduced due to the utilization of CTS to 
protect the 802.11g/n and Bluetooth transmissions. 
Multicast Audio 
Multicast audio from Push to Talk (PTT), Music on Hold (MMOH), and other applications are not supported 
when using Coexistence. 
Voice Quality 
Depending on the current data rate configuration, CTS may be sent to protect the Bluetooth transmissions 
when using Coexistence. 
In some environments, 6 Mbps may need to be enabled. 

Note: It is recommended to use 802.11a/n/ac when using Bluetooth, not only because both 802.11b/g/n and Bluetooth utilize 
the 2.4 GHz frequency, but also due to the limitations mentioned above. 
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Device Care 

To clean the Cisco Desk Phone 9800 Series, use a soft, moist cloth to wipe the device. 
Do not apply liquids or powders directly to the device as it can damage the device. 
Do not use bleach or other caustic products to clean the device. 
Do not use compressed air to clean the device as it can damage the device. 
For more information, refer to the Cisco Desk Phone 9800 Series User Guide at https://cisco.com/go/dp9800help 
 

  

https://cisco.com/go/dp9800help
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Wireless LAN Design 

The following network design guidelines must be followed to ensure adequate coverage, call capacity and seamless roaming 
for the Cisco Desk Phone 9800 Series. 

802.11 Network 

Use the following guidelines to plan channel usage for these wireless environments. 

5 GHz (802.11a/n/ac) 
5 GHz is the recommended frequency band for operating the Cisco Desk Phone 9800 Series. 
Generally, it is recommended for access points to use automatic channel selection instead of manually assigning channels. 
If there is intermittent interference, it may be necessary to statically assign channels to the access point or access points 
serving that area. 
The Cisco Desk Phone 9800 Series supports Dynamic Frequency Selection (DFS) and Transmit Power Control (TPC) as per 
802.11h, required for channels operating at 5.260 - 5.720 GHz, which encompass 16 out of the 25 possible channels. 
To ensure seamless roaming in a 802.11a/n/ac environment, it’s crucial to have at least 20 percent overlap with adjacent 
channels. For critical areas, increasing the overlap to 30% or more is recommended to to ensure that there can be at least 2 
access points available with a signal of -67 dBm or higher. Additionally, the Cisco Desk Phone 9800 Series complies with the 
access point’s receiver sensitivity (required signal level for the current data rate). 
 

Dynamic Frequency Selection (DFS) 

DFS dynamically instructs a transmitter to switch to another channel whenever radar signal is detected. If the access point 
detects radar, the radio on the access point will pause for at least 60 seconds while the access point passively scans for another 
usable channel. 
TPC allows the client and access point to exchange information, so that the client can dynamically adjust the transmit power. 
The client uses only enough energy to maintain association to the access point at a given data rate. As a result, the client 
contributes less to adjacent cell interference, which allows for more densely deployed, high-performance wireless LANs. 
If the access point detects repeated radar events, whether genuine or false alarms, it first determines if the radar signals are 
affecting a single channel (narrowband) or multiple channels (wideband). Then the access point potentially disables the 
affected channel or channels in the wireless LAN to mitigate interference. 
Having an access point operating on a non-DFS channel can help minimize voice interruptions. 
In case of radar activity, it’s recommended to have at least one access point per area that uses a non-DFS channel (UNII-1). 
This ensures that a channel remains available when an access point’s radio is in its hold-off period while scanning for a new 
usable channel. 
A UNII-3 channel (5.745 - 5.825 GHz) can optionally be used if available. 

For 5 GHz, 25 channels are available in the Americas, 16 channels in Europe, and 19 channels in Japan. 
Where UNII-3 is available, it is recommended to use UNII-1, UNII-2, and UNII-3 only to utilize a 12-channel set. 
If planning to use UNII-2 extended channels (channels 100 - 144), it is recommended to disable UNII-2 (channels 52-64) on 
the access point to avoid having so many channels enabled. 
Having many 5 GHz channels enabled in the wireless LAN can delay discovery of new access points. 
Below is a sample 5 GHz wireless LAN deployment 
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2.4 GHz (802.11b/g/n) 
In general, it is recommended for access points to utilize automatic channel selection instead of manually assigning channels 
to access points. 
If there is an intermittent interferer, then the access point or access points serving that area may need to have a channel 
statically assigned. 
In a 2.4 GHz (802.11b/g/n) environment, only non-overlapping channels must be utilized when deploying VoWLAN. 
Nonoverlapping channels have 22 MHz of separation and are at least 5 channels apart. 
There are only 3 non-overlapping channels in the 2.4 GHz frequency range (channels 1, 6, 11). 
Non-overlapping channels must be used and allow at least 20 percent overlap with adjacent channels when deploying the 
Cisco Desk Phone 9800 Series in an 802.11b/g/n environment, which allows for seamless roaming. 
Using an overlapping channel set such as 1, 5, 9, 13 is not a supported configuration. 

Below is a sample 2.4 GHz wireless LAN deployment. 

 

Signal Strength and Coverage 
To ensure acceptable voice quality, the Cisco Desk Phone 9800 Series should always have a signal of -67 dBm or higher when 
using 5GHz or 2.4 GHz, while the Cisco Desk Phone 9800 Series also meets the access point’s receiver sensitivity required 
signal level for the transmitted data rate. 
Ensure the Packet Error Rate (PER) is no higher than 1%. 
A minimum Signal to Noise Ratio (SNR) of 25 dB = -92 dBm noise level with -67 dBm signal should be maintained. 
It is recommended to have at least two access points on non-overlapping channels with at least -67 dBm signal with the 25 dB 
SNR to provide redundancy. 
To achieve maximum capacity and throughput, the wireless LAN should be designed to 24 Mbps. Higher data rates can 
optionally be enabled for other applications other than voice only that can take advantage of these higher data rates. 
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It’s recommended to set the minimum data rate to 11 Mbps or 12 Mbps for 2.4 GHz (dependent upon 802.11b client support 
policy) and 12 Mbps for 5 GHz, which should also be the only rate configured as a mandatory/basic rate. 
In some environments, 6 Mbps may need to be enabled as a mandatory/ basic rate. 
Due to the above requirements, a single channel plan should not be deployed. 
When designing the placement of access points, be sure that all key areas have adequate coverage (signal). 
Typical wireless LAN deployments for data only applications do not provide coverage for some areas where VoWLAN 
service is necessary such as elevators, stairways, and outside corridors. 
Microwave ovens, 2.4 GHz cordless phones, Bluetooth devices, or other electronic equipment operating in the 2.4 GHz band 
will interfere with the Wireless LAN. 
Microwave ovens operate on 2450 MHz, which is between channels 8 and 9 of 802.11b/g/n. Some microwaves are more 
heavily shielded than others, which reduces the spread of the energy. Microwave emissions can impact channel 11, while some 
microwaves can affect the entire 2.4 GHz frequency range (channels 1 through 11). To avoid microwave interference, select 
channel 1 when using access points that are located near microwaves. 
Most microwave ovens, Bluetooth, and frequency hopping devices do not have the same effect on the 5 GHz frequency. The 
802.11a/n/ac technology provides more non-overlapping channels and typically lower initial RF utilization. For voice 
deployments, it is suggested to use 802.11a/n/ac for voice and use 802.11b/g/n for data. 
However, there are products that also utilize the non-licensed 5 GHz frequency (e.g. 5.8 GHz cordless phones, which can 
impact UNII-3 channels). 

Data Rates 
It is recommended to disable rates below 12 Mbps for 5 GHz deployments and below 12 Mbps for 2.4 GHz deployments 
where capacity and range are factored in for best results. 
The Cisco Desk Phone 9800 Series is 1x1 with single antenna, therefore they support up to MCS 7 data rates for 802.11n (up 
to 72 Mbps).  For 802.11ac, the Cisco Desk Phone 9800 Series supports up to VHT80 MCS 9 1SS (up to 433 Mbps). 
If 802.11b clients are not allowed in the wireless network, then it is strongly recommended to disable the data rates below 12 
Mbps. This will eliminate the need to send CTS frames for 802.11g/n protection as 802.11b clients cannot detect these OFDM 
frames. 
When 802.11b clients exist in the wireless network, then an 802.11b rate must be enabled and only an 802.11b rate can be 
configured as a mandatory/ basic rate. 
For a voice only application, data rates higher than 24 Mbps can optionally be enabled or disabled.  To preserve high capacity 
and throughput, data rates of 24 Mbps and higher should be enabled. 
If deploying in an environment where excessive retries may be a concern, then a limited set of the data rates can be used, 
where the lowest enabled rate is the mandatory/ basic rate. 
For rugged environments or deployments requiring maximum range, it is recommended to enable 6 Mbps as a mandatory/ 
basic rate. 
Note: that capacity and throughput are reduced when lower rates are enabled. 

Rugged Environments 
When deploying the Cisco Desk Phone 9800 Series in a rugged environment (e.g. manufacturing, warehouse, retail), 
additional tuning on top of the standard design recommendations may be necessary. 
Below are the key items to focus on when deploying a wireless LAN in a rugged environment. 

Access Point and Antenna Selection 
For rugged environments, it is recommended to select an access point platform that requires external antennas. It is 
also important to ensure an antenna type is selected which can operate well in rugged environments. 
Access Point Placement 
It is crucial that line of sight to the access point’s antennas is maximized by minimizing any obstructions between the 
Cisco Desk Phone 9800 Series and the access point. Ensure that the access point and/or antennas are not mounted 
behind any obstruction or on or near a metal or glass surface. 
If access points with integrated internal antennas are to be used in some areas, then it is recommended to mount those 
access points on the ceiling as they have omni-directional antennas and are not designed to be wall mounted. 
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Frequency Band 
As always, it is recommended to use 5 GHz. Use of 2.4 GHz, especially when 802.11b rates are enabled, may not 
work well. 
For the 5 GHz channel set, it is recommended to use a 8 or 12 channel plan only; disable UNII-2 extended channels if 
possible. 
Data Rates 
The standard recommended data rate set may not work well if multipath is present at an elevated level. 
Therefore, it is recommended to enable lower data rates (e.g. 6 Mbps) to operate better in such an environment. 
If using for voice only, then data rates above 24 Mbps can be disabled to increase first transmission success. If the 
same band is also used for data, video or other applications, then it’s suggested to keep the higher data rates enabled. 
Transmit Power 
Due to the potential of elevated multipath in rugged environments, the transmit power of the access point and Cisco 
Desk Phone 9800 Series should also be restricted. This is more important if planning to deploy 2.4 GHz in a rugged 
environment. If using auto transmit power, the access point transmit power can be configured to use a specified range 
(maximum and 
minimum power levels) to prevent the access point from transmitting too hot as well as too weak (e.g. 5 GHz 
maximum of 16 dBm and minimum of 11 dBm). 
Fast Roaming 
It is recommended to utilize 802.11r/ Fast Transition (FT) for fast roaming. Enabling 802.11r (FT) also reduces the 
number of frames in the handshake when roaming to only two frames. Reducing the number of frames during a roam, 
increases the chances of roam success. 
When using 802.1x authentication, it is important to use the recommended EAPOL key settings. 
Quality of Service (QoS) 
Need to ensure that DSCP values are preserved throughout the wired network, so that the WMM UP tag for voice, 
video, and call control frames can be set correctly. 

Multipath 
Multipath occurs when RF signals take multiple paths from a source to a destination. 
A part of the signal goes to the destination while another part bounces off an obstruction, then goes on to the destination. As a 
result, part of the signal encounters delays and travels a longer path to the destination, which creates signal energy loss. 
When the different waveforms combine, they cause distortion and affect the decoding capability of the receiver, as the signal 
quality is poor. 
Multipath can exist in environments where there are reflective surfaces (e.g. metal, glass, etc.). Avoid mounting access points 
on these surfaces. 
Below is a list of multipath effects: 

Data Corruption 
Occurs when multipath is so severe that the receiver is unable to detect the transmitted information. 
Signal Nulling 
Occurs when the reflected waves arrive exactly out of phase with the main signal and cancel the main signal 
completely. 
Increased Signal Amplitude 
Occurs when the reflected waves arrive in phase with the main signal and add on to the main signal thereby increasing 
the signal strength. 
Decreased Signal Amplitude 
Occurs when the reflected waves arrive out of phase to some extent with the main signal thereby reducing the signal 
amplitude. 

Use of Orthogonal Frequency Division Multiplexing (OFDM), which is used by 802.11a/n/ac and 802.11g/n, can help to 
reduce issues seen in high multipath environments. 
If using 802.11b in a high multipath environment, lower data rates should be used in those areas (e.g. 1 and 2 Mbps). 
Use of antenna diversity can also help in such environments. 
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Security 

When deploying a wireless LAN, security is essential.  The Cisco Desk Phone 9800 Series supports the following wireless 
security features. 

WLAN Authentication 

• WPA2 and WPA (802.1x authentication) 
• WPA2-PSK and WPA-PSK (Pre-Shared key) 
• WPA3-SAE (Simultaneous Authentication of Equals) 
• EAP-FAST (Extensible Authentication Protocol - Flexible Authentication via Secure Tunneling) 
• EAP-TLS (Extensible Authentication Protocol - Transport Layer Security) 
• PEAP (Protected Extensible Authentication Protocol - Generic Token Card/ Microsoft Challenge Handshake 

Authentication Protocol version 2) 
• None 

WLAN Encryption 

• AES (minimum 128-bit Advanced Encryption Standard) 

• TKIP / MIC (Temporal Key Integrity Protocol / Message Integrity Check) 

WPA3-Enterprise 

• Key derivation and confirmation 

Minimum 256-bit Hashed Message Authentication Mode (HMAC) with Secure Hash Algorithm (HMAC-SHA256) 

• Robust management frame 

Minimum 128-bit Broadcast/Multicast Integrity Protocol Cipher-based Message Authentication Code (BIP-CMAC-
128) 

Note: CCMP256, GCMP128 and GCMP256 encryption ciphers are not supported. 

The Cisco Desk Phone 9800 Series also supports the following additional security features. 
• Image authentication 
• Device authentication 
• File authentication 
• Signaling authentication 
• Media encryption (SRTP) 
• Signaling encryption (TLS) 
• Certificate authority proxy function (CAPF) 
• Secure profiles 
• Encrypted configuration files 

Extensible Authentication Protocol - Flexible Authentication via Secure Tunneling (EAP-
FAST) 
Extensible Authentication Protocol - Flexible Authentication via Secure Tunneling (EAP-FAST) encrypts EAP transactions 
within a Transport Level Security (TLS) tunnel between the access point and the Remote Authentication Dial-in User Service 
(RADIUS) server such as the Cisco Identity Service Engine (ISE). 
The TLS tunnel uses Protected Access Credentials (PACs) for authentication between the client (the Cisco Desk Phone 9800 
Series) and the RADIUS server. The server sends an Authority ID (AID) to the client, which in turn selects the appropriate 
PAC. The client returns a PAC-Opaque to the RADIUS server. The server decrypts the PAC with its primary key. Both 
endpoints now have the PAC key, and a TLS tunnel is created. EAP-FAST supports automatic PAC provisioning, but it must 
enable on the RADIUS server. 
To enable EAP-FAST, a certificate must be installed on to the RADIUS server. 
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The Cisco Desk Phone 9800 Series currently supports automatic provisioning of the PAC only. Therefore, enable Allow 
anonymous in-band PAC provisioning on the RADIUS server. 
Both EAP-GTC and EAP-MSCHAPv2 must be enabled when Allow anonymous in-band PAC provisioning is enabled. 
EAP-FAST requires a user account to be created on the authentication server. 
If anonymous PAC provisioning is not allowed in the production wireless LAN environment, then a staging RADIUS server 
can be set up for initial PAC provisioning of the Cisco Desk Phone 9800 Series. 
This requires that the staging RADIUS server are set up as a secondary EAP-FAST server and components are replicated from 
the product primary EAP-FAST server, which include user and group database and EAP-FAST primary key and policy info. 
Ensure the production primary EAP-FAST RADIUS server is set up to send the EAP-FAST primary keys and policies to the 
staging secondary EAP-FAST RADIUS server, which will then allow the Cisco Desk Phone 9800 Series to use the 
provisioned PAC in the production environment where Allow anonymous in-band PAC provisioning is disabled. 
When it is time to renew the PAC, then authenticated in-band PAC provisioning will be used. Therefore, ensure that Allow 
authenticated in-band PAC provisioning is enabled. 
Ensure that the Cisco Desk Phone 9800 Series has connected to the network during the grace period to ensure it can use its 
existing PAC created either using the active or retired primary key to get issued a new PAC. 
Is recommended to only have the staging wireless LAN pointed to the staging RADIUS server and to disable the staging 
access point radios when not being used. 

Extensible Authentication Protocol - Transport Layer Security (EAP-TLS) 
Extensible Authentication Protocol - Transport Layer Security (EAP-TLS) is using the TLS protocol with PKI to secure 
communications to the authentication server. 
TLS provides a way to use certificates for both user and server authentication and for dynamic session key generation. A 
certificate is required to be installed. 
EAP-TLS provides excellent security but requires client certificate management. 
EAP-TLS may also require a user account to be created on the authentication server matching the common name of the 
certificate imported into the Cisco Desk Phone 9800 Series. 
It is recommended to use a complex password for this user account and that EAP-TLS is the only EAP type enabled on the 
RADIUS server. 

Protected Extensible Authentication Protocol (PEAP) 
Protected Extensible Authentication Protocol (PEAP) uses server-side public key certificates to authenticate clients by creating 
an encrypted SSL/TLS tunnel between the client and the authentication server. 
The ensuing exchange of authentication information is then encrypted, and user credentials are safe from eavesdropping. 
PEAP-GTC and PEAP-MSCHAPv2 are supported inner authentication protocols. 
PEAP requires a user account to be created on the authentication server. 

Quality of Service (QoS) 

Quality of Service enables queuing to ensure high priority for voice and call traffic. 
To enable proper queuing for voice and call control traffic use the following guidelines. 
• Ensure that WMM is enabled on the access point. 
• Create a QoS policy on the access point giving priority to voice and call control traffic. 

Traffic Type DSCP 802.1p WMM UP Port Range 
Voice EF (46) 5 6 RTP/RTCP port negotiated with remote peer. 
Call Control CS3 (24) 3 4 TCP/UDP port configured by admin 

• Be sure that voice and call control packets have the proper QoS markings and other protocols are not using the same QoS 
markings. 
• Enable Differentiated Services Code Point (DSCP) preservation on the Cisco IOS switch. 
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Call Admission Control (CAC) 
The Cisco Desk Phone 9800 Series does not support Call Admission Control of voice stream. 
If TSPEC is enabled for voice the access point, then the priority of voice frames will be downgraded. 

Wired QoS 
Configure QoS settings and policies for the necessary network devices. 
Configuring Cisco Switch Ports for WLAN Devices 
Configure the Cisco Wireless LAN Controller and Cisco Access Point switch ports as well as any uplink switch ports. 
If utilizing Cisco IOS Switches, use the following switch port configurations. 

Enable COS trust for Cisco Wireless LAN Controller 
mls qos 
! 
interface X 
mls qos trust cos 
Enable DSCP trust for Cisco Access Points 
mls qos 
! 
interface X 
mls qos trust dscp 

If utilizing Cisco Meraki MS Switches, refer to the Cisco Meraki MS Switch VoIP Deployment Guide. 
https://meraki.cisco.com/lib/pdf/meraki_whitepaper_msvoip.pdf 
Note: When using the Cisco Wireless LAN Controller, DSCP trust must be implemented or must trust the UDP data ports 
used by the Cisco Wireless LAN Controller (CAPWAP = UDP 5246 and 5247) on all interfaces where wireless packets will 
traverse to ensure QoS markings are correctly set. 
Configuring Cisco Switch Ports for Wired IP Phones 
Enable the Cisco wired IP phone switch ports for Cisco phone trust. 
Below is a sample switch configuration: 

mls qos 
! 
Interface X 
mls qos trust device cisco-phone 
mls qos trust dscp 

Roaming 

The Cisco Desk Phone 9800 Series enables both sets of frequencies, which allows the Cisco Desk Phone 9800 Series to 
connect to either 5 GHz or 2.4GHz and enables interband roaming support. 
802.1x without 802.11r (FT) can introduce delay during roaming due to its requirement for full re-authentication. WPA, 
WPA2 and WPA3 introduce additional transient keys and can lengthen roaming time. 
When 802.11r (FT) is utilized, roaming times can be reduced to less than 100 ms, where the transition time from one access 
point to another will not be audible to the user. 
The Cisco Desk Phone 9800 Series supports 802.11r (FT). 
Authentication Roaming Time Table 

Authentication Roaming Time 
WPA/WPA2/WPA3 Personal 150 ms 
WPA2 Enterprise 300 ms 
802.11r (FT) < 100 ms 

The Cisco Desk Phone 9800 Series manages the scanning and roaming events. 
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The roaming trigger for most roaming events should meet the required RSSI differential based on the current RSSI. This 
ensures seamless roaming without voice interruptions. 

Fast Secure Roaming (FSR) 
802.11r / Fast Transition (FT) is the recommended deployment model for all environment types where frequent roaming 
occurs. 
Cisco Centralized Key Management (CCKM) is not supported but requires 802.1x authentication. 
802.11r (FT) enables fast secure roaming and limits the off-network time to minimize gaps during calls. 
802.1x or PSK without 802.11r (FT) and 802.1x without FT can introduce delay during roaming due to its requirement for full 
re-authentication. WPA, WPA2 and WPA3 introduce additional transient keys and can lengthen roaming time. 
802.11r (FT) centralizes the key management and reduces the number of key exchanges. 
When 802.11r (FT) is utilized, roaming times can be reduced from 400-500 ms to less than 100 ms, where that transition time 
from one access point to another will not be audible to the user. 
There are two methods of 802.11r (FT) roaming. 

Over the Air 
The client communicates directly with the target access point using 802.11 authentication with the FT authentication 
algorithm. 
Over the Distribution 
The client communicates with the target access point through the current access point. The communication between 
the client and the target access point is carried in FT action frames between the client and the current access point via 
the WLAN controller. 

802.11r (FT) utilizing the Over the Air method is the recommended fast secure roaming model to deploy. 
Since the 802.11r (FT) plus Over the Distribution method requires connectivity to the currently associated access point, this 
method may not work well if the phone is not always able to communicate with the current access point as well as the target 
access point, which could occur in non-open environments if line of sight to both the current access point and the target access 
point cannot be retained when a roaming event occurs. 
The Cisco Desk Phone 9800 Series supports 802.11r (FT) with WPA2-PSK, WPA3-SAE or WPA2/WPA3 enterprise. 

FSR Type Authentication Key Management Encryption PMF 
802.11r (FT) PSK WPA-PSK WPA-PSK-SHA256 FT-PSK AES No 
802.11r (FT) WPA3 SAE FT-SAE AES Yes 
802.11r (FT) EAP-TLS WPA-EAP FT-EAP AES No 
802.11r (FT) EAP-TLS (WPA3) WPA-EAP-SHA256 FT-EAP AES Yes 
802.11r (FT) EAP-FAST WPA-EAP FT-EAP AES No 
802.11r (FT) EAP-FAST(WPA3) WPA-EAP-SHA256 FT-EAP AES Yes 
802.11r (FT) EAP-PEAP WPA-EAP FT-EAP AES No 
802.11r (FT) EAP-PEAP(WPA3) WPA-EAP-SHA256 FT-EAP AES Yes 

Note: If deploying the Cisco Desk Phone 9800 Series into an environment where other Wi-Fi phone models exist but those 
Wi-Fi phone models do not support 802.11r (FT), then should be able to use that same pre-existing SSID for the Cisco Desk 
Phone 9800 Series, but is recommended to enable 802.11r (FT) utilizing the Over the Air method on top of the other 
preexisting key management types (e.g. 802.1x); assuming the other Wi-Fi phone models can interoperate in an 802.11r (FT) 
enabled network while not utilizing 802.11r (FT). 
The access point must support AES (CCMP128) as TKIP can only be used as the broadcast/multicast cipher. 

Interband Roaming 
The Cisco Desk Phone 9800 Series enables both sets of frequencies, which enables interband roaming and currently gives 
preference to the strongest signal. Typically, this will give preference to 2.4 GHz over 5 GHz due to 2.4 GHz having a stronger 
signal in general assuming the power levels are the same. 
At power on, the Cisco Desk Phone 9800 Series will scan all 2.4 and 5 GHz channels, then attempt to associate to an access 
point for the configured network if available. 
It is recommended to perform a spectrum analysis to ensure that the desired bands can be enabled to perform interband 
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roaming. 

Power Management 

The power supply is required to enable the Cisco Desk Phone 9800 Series for wireless LAN mode, as there is no internal 
battery. 
Wireless LAN is automatically disabled temporarily when Ethernet is connected to the Cisco Desk Phone 9800 Series but will 
be automatically re-enabled once Ethernet is disconnected if Wireless LAN was enabled previously. 
The Cisco Desk Phone 9800 Series primarily uses fast sleep  mode (no Wi-Fi power save) when in idle or on call. 
Null Power Save (PS-NULL) frames are utilized for off-channel scanning. 
 

Delivery Traffic Indicator Message (DTIM) 
It is recommended to set the DTIM period to 2 with a beacon period of 100 ms. 
Since the Cisco Desk Phone 9800 Series uses fast-sleep mode, the DTIM period will not be used to schedule wake-up periods 
to check for broadcast and multicast packets as well as any unicast packets. 
Broadcast and multicast traffic will be queued until the DTIM period when there are power-save-enabled clients associated to 
the access point, so DTIM will determine how quickly these packets can be delivered to the client. If using multicast 
applications, a shorter DTIM period can be used. 
When multiple multicast streams exist on the wireless LAN frequently, then it is recommended to set the DTIM period to 1. 
Call Capacity 

Design the network to accommodate the desired call capacity. 
The Cisco Access Point can support up to 27 bi-directional voice streams for both 802.11a/n/ac and 802.11g/n at a data rate of 
24 Mbps or higher. To achieve this capacity, there must be minimal wireless LAN background traffic and initial radio 
frequency (RF) utilization. 
The number of calls may vary depending on the data rate, initial channel utilization, and the environment. 
Multicast 

When enabling multicast in the wireless LAN, performance and capacity must be considered. 
If there is an associated client that is in power save mode, then all multicast packets will be queued until the DTIM period. 
The Cisco Desk Phone 9800 Series utilizes fast-sleep mode primarily, but if there is an associated client that is in power save 
mode, then all multicast packets will be queued until the DTIM period. 
With multicast, there is no guarantee that the packet will be received timely by the client. 
The multicast traffic will be sent at the highest mandatory / basic data rate enabled on the access point, so will want to ensure 
that only the lowest enabled rate is configured as the only mandatory / basic rate. 
The client will send the IGMP join request to receive that multicast stream. The client will send the IGMP leave when the 
session is to be ended. 
The Cisco Desk Phone 9800 Series supports the IGMP query feature, which can be used to reduce the amount of multicast 
traffic on the wireless LAN when not necessary. 
Ensure that IGMP snooping is also enabled on all switches. 
Note: If using Coexistence where 802.11b/g/n and Bluetooth are being used simultaneously, then multicast voice is not 
supported. 
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Configuring the Cisco Wireless LAN 

Cisco AireOS Wireless LAN Controller and Lightweight Access Points 

When configuring the Cisco AireOSWireless LAN Controller and Lightweight Access Points, use the following guidelines: 
• Enable 802.11r (FT)  
• CCKM is Disabled 
• Set Quality of Service (QoS) to Platinum 
• Set the WMM Policy to Required 
• Ensure Session Timeout is enabled and configured correctly 
• Ensure Broadcast Key Interval is enabled and configured correctly 
• Ensure Aironet IE is Disabled 
• Disable P2P (Peer to Peer) Blocking Action 
• Ensure Client Exclusion is configured correctly 
• Disable DHCP Address Assignment Required 
• Set Protected Management Frame (PMF) to Optional or Required for WPA3 
• Set MFP Client Protection to Optional or Required for WPA3 
• Set the DTIM Period to 2 
• Set Client Load Balancing to Disabled 
• Set Client Band Select to Disabled 
• Set IGMP Snooping to Enabled 
• Enable Symmetric Mobile Tunneling Mode if Layer 3 mobility is utilized 
• Configure the Data Rates as necessary 
• Configure Auto RF as necessary 
• Set EDCA Profile to Voice Optimized or Voice and Video Optimized 
• Set Enable Low Latency MAC to Disabled 
• Ensure that Power Constraint is Disabled 
• Enable Channel Announcement and Channel Quiet Mode 
• Configure the High Throughput Data Rates as necessary 
• Configure the Frame Aggregation settings 
• Enable CleanAir if utilizing Cisco access points with CleanAir technology 
• Configure Multicast Direct Feature as necessary 
• Set the 802.1p tag to 5 for the Platinum QoS profile 

802.11 Network Settings 
It is recommended to operate the Cisco Desk Phone 9800 Series only on the 5 GHz band due to the availability of many 
channels and fewer interferers compared to the 2.4 GHz band. 
To use 5 GHz frequency, ensure that the 802.11a/n/ac Network Status is Enabled. 
Set the Beacon Period to 100 ms. 
Maximum Allowed Clients can be configured as necessary. 
It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps and higher as supported (optional) rates. 
However, some environments may require 6 Mbps to be enabled as a mandatory (basic) rate. 
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To use 2.4 GHz, ensure that the 802.11b/g/n Network Status and 802.11g are Enabled. 
Set the Beacon Period to 100 ms. 
Short Preamble should be Enabled in the 2.4 GHz radio configuration setting on the access point when there’re no legacy 
clients requiring a long preamble in the wireless LAN. By using the short preamble instead of long preamble, the wireless 
network performance is improved. 
Maximum Allowed Clients can be configured as necessary. 
It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps and higher as supported (optional) rates assuming 
that there will not be any 802.11b only clients that will connect to the wireless LAN; however, some environments may 
require 6 Mbps to be enabled as a mandatory (basic) rate. 
If 802.11b clients exist, then 11 Mbps should be set as the mandatory (basic) rate and 12 Mbps and higher as supported 
(optional). 
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Auto RF (RRM) 

When using the Cisco Wireless LAN Controller, it is recommended to enable Auto RF to manage the channel and transmit 
power settings. 
Configure the access point transmit power level assignment method for either 5 or 2.4 GHz depending on which frequency 
band is to be utilized. 
If using automatic power level assignment, a maximum and minimum power level can be specified. 

 

When using 5 GHz, it’s recommended to limit the number of channels (e.g. 12 channels only) to avoid any potential delay in 
access point discovery caused by scanning many channels. 
The 5 GHz channel width can be configured as 20 MHz or 40 MHz for using Cisco 802.11n Access Points and as 20 MHz, 
40MHz or 80 MHz for using Cisco 802.11ac Access Points. 
It is recommended to utilize the same channel width for all access points. 
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When using 2.4 GHz, only channels 1, 6, and 11 should be enabled in the DCA list. 
It is recommended to configure the 2.4 GHz channel as 20 MHz even when using Cisco 802.11n Access Points capable of 40 
MHz due to the limited number of channels available in 2.4 GHz. 

 

Individual access points can be configured to override the global setting to use dynamic channel and transmit power 
assignment for either 5 or 2.4 GHz depending on which frequency band is to be utilized. 
Other access points can be enabled for automatic assignment method and account for the access points that are statically 
configured. 
This may be necessary if there is an intermittent source of interference in the area. 
The 5 GHz channel width can be configured as 20 MHz or 40 MHz when using Cisco 802.11n Access Points and 20 MHz, 40 
MHz, or 80 MHz when using Cisco 802.11ac Access Points. 
It is recommended to use channel bonding only when using 5 GHz. 
It is recommended to utilize the same channel width for all access points. 
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Client Roaming 

The Cisco Desk Phone 9800 Series does not utilize the RF parameters in the Client Roaming section of the Cisco Wireless 
LAN Controller as scanning and roaming are managed independently by the device itself. 

EDCA Parameters 

Set the EDCA profile to either Voice Optimized or Voice & Video Optimized and disable Low Latency MAC for either 5 
or 2.4 GHz depending on which frequency band is to be utilized. 
Low Latency MAC (LLM) reduces the number of retransmissions to 2-3 per packet depending on the access point platform, so 
it can cause issues if multiple data rates are enabled. 
LLM is not supported on the Cisco 802.11n/ac Access Points. 

 

DFS (802.11h) 

Power Constraint should be left un-configured or set to 0 dB. 
Channel Announcement and Channel Quiet Mode should be Enabled. 

 

High Throughput (802.11n/ac) 

The 802.11n data rates can be configured per radio (2.4 GHz and 5 GHz). 
802.11ac data rates are applicable to 5 GHz only. 
Ensure that WMM is enabled and WPA2/WPA3(AES) is configured to utilize 802.11n/ac data rates. 
The Cisco Desk Phone 9800 Series supports HT MCS 0 – MCS 7 and VHT MCS 0 – MCS 9 1SS data rates only, but higher 
MCS rates can optionally be enabled if there are other 802.11n/ac clients utilizing the same band frequency that include 
MIMO antenna technology, which can take advantage of those higher data rates. 
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Frame Aggregation 

Frame aggregation is a process of packaging multiple MAC Protocol Data Units (MPDUs) or MAC Service Data Units 
(MSDUs) together to reduce the overheads where in turn throughput and capacity can be optimized. 
Aggregation of MAC Protocol Data Unit (A-MPDU) requires the use of block acknowledgements. 
It is required to adjust the A-MPDU and A-MSDU settings to the following to optimize the experience with the Cisco Desk 
Phone 9800 Series. 

A-MSDU 
User Priority 1, 2 = Enabled 
User Priority 0, 3, 4, 5, 6, 7 = Disabled 
A-MPDU 
User Priority 0, 3, 4, 5 = Enabled 
User Priority 1, 2, 6, 7 = Disabled 

Use the following commands to configure the A-MPDU and A-MSDU settings according to the Cisco Desk Phone 9800 
Series requirements. 
To configure the 5 GHz settings, enable the 802.11a network first, then re-enable it after the changes are complete. 

config 802.11a 11nSupport a-msdu tx priority 1 enable 
config 802.11a 11nSupport a-msdu tx priority 2 enable 
config 802.11a 11nSupport a-msdu tx priority 0 disable 
config 802.11a 11nSupport a-msdu tx priority 3 disable 
config 802.11a 11nSupport a-msdu tx priority 4 disable 
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config 802.11a 11nSupport a-msdu tx priority 5 disable 
config 802.11a 11nSupport a-msdu tx priority 6 disable 
config 802.11a 11nSupport a-msdu tx priority 7 disable 
 
config 802.11a 11nSupport a-mpdu tx priority 0 enable 
config 802.11a 11nSupport a-mpdu tx priority 3 enable 
config 802.11a 11nSupport a-mpdu tx priority 4 enable 
config 802.11a 11nSupport a-mpdu tx priority 5 enable 
config 802.11a 11nSupport a-mpdu tx priority 1 disable 
config 802.11a 11nSupport a-mpdu tx priority 2 disable 
config 802.11a 11nSupport a-mpdu tx priority 6 disable 
config 802.11a 11nSupport a-mpdu tx priority 7 disable 
 

To configure the 2.4 GHz settings, enable the 802.11b/g network first, then re-enable it after the 
changes are complete. 

config 802.11b 11nSupport a-msdu tx priority 1 enable 
config 802.11b 11nSupport a-msdu tx priority 2 enable 
config 802.11b 11nSupport a-msdu tx priority 0 disable 
config 802.11b 11nSupport a-msdu tx priority 3 disable 
config 802.11b 11nSupport a-msdu tx priority 4 disable 
config 802.11b 11nSupport a-msdu tx priority 5 disable 
config 802.11b 11nSupport a-msdu tx priority 6 disable 
config 802.11b 11nSupport a-msdu tx priority 7 disable 
 
config 802.11b 11nSupport a-mpdu tx priority 0 enable 
config 802.11b 11nSupport a-mpdu tx priority 3 enable 
config 802.11b 11nSupport a-mpdu tx priority 4 enable 
config 802.11b 11nSupport a-mpdu tx priority 5 enable 
config 802.11b 11nSupport a-mpdu tx priority 1 disable 
config 802.11b 11nSupport a-mpdu tx priority 2 disable 
config 802.11b 11nSupport a-mpdu tx priority 6 disable 
config 802.11b 11nSupport a-mpdu tx priority 7 disable 
 

To view the current A-MPDU and A-MSDU configuration, enter either show 802.11a for 5 GHz or show 802.11b for 2.4 
GHz. 

802.11n Status: 
A-MSDU Tx: 

Priority 0............................... Disabled 
Priority 1............................... Enabled 
Priority 2............................... Enabled 
Priority 3............................... Disabled 
Priority 4............................... Disabled 
Priority 5............................... Disabled 
Priority 6............................... Disabled 
Priority 7............................... Disabled 

A-MPDU Tx: 
Priority 0............................... Enabled 
Priority 1............................... Disabled 
Priority 2............................... Disabled 
Priority 3............................... Enabled 
Priority 4............................... Enabled 
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Priority 5............................... Enabled 
Priority 6............................... Disabled 
Priority 7............................... Disabled 

 

CleanAir 

CleanAir should be Enabled when utilizing Cisco access points with CleanAir technology to detect any existing interferers. 
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Rx Sop Threshold 

It is recommended to use the default value for Rx Sop Threshold. 

 

WLAN Settings 
It is recommended to have a separate SSID for the Cisco Desk Phone 9800 Series. 
However, you can also use an existing SSID that is configured to support voice capable Cisco Wireless LAN endpoints. 
The SSID to be used by the Cisco Desk Phone 9800 Series can be configured to only apply to a certain 802.11 radio type (e.g. 
802.11a only). 
It is recommended to operate the Cisco Desk Phone 9800 Series on the 5 GHz band only due to availability of many channels 
and fewer interferers compared to the 2.4 GHz band. 
Ensure that the selected SSID is not utilized by any other wireless LANs as that could lead to failures when powering on or 
during roaming, especially when a different security type is utilized. 
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To utilize 802.11r (FT) for fast secure roaming, enable Fast Transition. 
It is recommended to uncheck Over the DS to utilize the Over the Air method instead of the Over the Distribution System 
method. 
Protected Management Frame should be set to Optional or Required for WPA3. 
Enable WPA2/WPA3 policy with AES encryption then FT 802.1x, FT PSK or FT SAE for authenticated key management 
type depending on whether 802.1x or PSK/SAE is to be utilized. 
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802.11x, PSK, or SAE can be enabled to utilize the same SSID for various types of voice clients. Some clients may not 
support 802.11r (FT), depending on whether 802.1x, PSK, or SAE is used. 
RADIUS Authentication and Account Servers can be configured per SSID to override the global list. 
If Enabled or not specified (set to None), then the global list of RADIUS servers defined at Security > AAA > RADIUS will 
be utilized. 
All EAP parameters, except for EAP-Broadcast Key Interval, can be set per SSID or globally. EAP-Broadcast Key Interval 
can only be configured at the global level. 
To configure the EAP parameters per SSID, check Enable in the EAP Parameters section and enter the desired values. 

 

The WMM policy should be set to Required only if the Cisco Desk Phone 9800 Series or other WMM-enabled phones will be 
using this SSID. 
If there are non-WMM clients on the WLAN, it is recommended to put those clients on a separate WLAN. 
If non-WMM clients must utilize the same SSID as the Cisco Desk Phone 9800 Series, ensure the WMM policy is set to 
Allowed. 
Enabling WMM will enable the 802.11e version of QBSS. 
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Configure Enable Session Timeout as needed. It is recommended to enable the session timeout for 86400 seconds to avoid 
potential interruptions during audio calls and periodically re-validate client credentials to ensure that the client is using valid 
credentials. 
Disable Aironet Extensions (Aironet IE). 
Peer to Peer (P2P) Blocking Action should be disabled. 
Configure Client Exclusion as needed. 
The Maximum Allowed Clients Per AP Radio can be configured as needed. 
Off Channel Scanning Defer can be tuned to defer scanning for certain queues as well as the scan defer time. 

If using best effort applications frequently or not preserving DSCP values for priority applications (e.g. voice and call control) 
to the access point, it is recommended to enable the lower priority queues (0-3) along with the higher priority queues (4-6) to 
defer off channel scanning as well as potentially increase the scan defer time. 
For deployments with frequent EAP failures, it is recommended to enable priority queue 7 to defer off channel scanning 
during EAP exchanges. 
DHCP Address Assignment Required should be disabled. 
Management Frame Protection should be set to Optional or Required for WPA3. 
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Use a DTIM Period of 2 with a beacon period of 100 ms. 
Ensure Client Load Balancing and Client Band Select are disabled. 
It is recommended to set Re-anchor Roamed Voice Clients to Disabled as this can cause brief interruptions with wireless 
LAN connectivity when a call is terminated after performing an inter-controller roaming. 
Keep the default settings for 802.11k and 802.11v. 
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AP Groups 

AP Groups can be created to specify which WLANs / SSIDs are to be enabled and which interface they should be mapped to 
as well as what RF Profile parameters should be used for the access points assigned to the AP Group. 
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On the WLANs tab, select the desired SSIDs and interfaces to map to then select Add. 

 

On the RF Profile tab, select the desired 802.11a or 802.11b RF Profile, then select Apply. 
If changes are made after access points have joined the AP Group, then those access points will reboot once those changes are 
made. 

 

On the APs tab, select the desired access points then select Add APs. 

Those access points will then reboot. 
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Controller Settings 
Ensure the Cisco Wireless LAN Controller hostname is configured correctly. 
Enable Link Aggregation (LAG) when utilizing multiple ports on the Cisco Wireless LAN Controller. 
Configure the desired AP multicast mode. 

 

To utilize multicast, Enable Global Multicast Mode and Enable IGMP Snooping should be checked. 
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When utilizing layer 3 mobility, Symmetric Mobility Tunneling should be Enabled. 
In the recent versions, Symmetric Mobility Tunneling is enabled by default and non-configurable. 

 

When multiple Cisco Wireless LAN Controllers are part of the same mobility group, ensure to add the IP address and MAC 
address of each Cisco Wireless LAN Controller to the Static Mobility Group Members configuration. 

 

Call Admission Control (CAC) 
Admission Control Mandatory for Voice and Video should be disabled. 
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In the Media settings, Unicast Video Redirect and Multicast Direct Enable should be enabled. 
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RF Profiles 
RF Profiles can be created to specify the frequency bands, data rates, RRM settings, etc. that a group of access points should 
use. 
For the SSID used by the Cisco Desk Phone 9800 Series, it’s recommended to apply it to 5 GHz radios only. 
RF Profiles are applied to an AP group once created. 
When creating an RF Profile, the RF Profile Name and Radio Policy must be defined. 
Select 802.11a or 802.11b/g for the Radio Policy. 

 

On the 802.11 tab, configure the data rates as desired. 
It is recommended to enable 12 Mbps as Mandatory and 18 Mbps and higher as Supported. However, some environments 
may require 6 Mbps to be enabled as a mandatory (basic) rate. 
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On the RRM tab, the Maximum Power Level Assignment and Minimum Power Level Assignment settings as well as other 
DCA, TPC, and Coverage Hole Detection settings can be configured. 
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On the High Density tab, Maximum Clients, Multicast Data Rates, and Rx Sop Threshold can be configured. 
It is recommended to use the default value for Rx Sop Threshold. 

 

FlexConnect Groups 
All access points configured for FlexConnect mode need to be added to a FlexConnect Group. 

When utilizing 802.11r (FT), seamless roaming can only occur when roaming to access points within the same FlexContext 
Group. 
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The maximum number of access points allowed per FlexConnect Group is limited, which is WLC model specific. 

 

 

 

Multicast Direct 
In the Media Stream settings, Multicast Direct feature should be enabled. 
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After Multicast Direct feature is enabled, there will be an option to enable Multicast Direct in the QoS menu of the WLAN 
configuration. 
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QoS Profiles 
Configure the four QoS profiles (Platinum, Gold, Silver, Bronze), by selecting 802.1p as the protocol type and set the 802.1p 
tag for each profile. 

• Platinum = 5 
• Gold = 4 
• Silver = 2 
• Bronze = 1 
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Advanced Settings 

Advanced EAP Settings 

All EAP parameters, except for the EAP-Broadcast Key Interval, can be configured at the SSID level or at the global level. 
EAP-Broadcast Key Interval  can only be configured at the global level. 
To view or configure the EAP parameters, select Security > Advanced EAP. 

 

To view the EAP parameters on the Cisco Wireless LAN Controller via command line, enter the following command. 

(Cisco Controller) >show advanced eap 
EAP-Identity-Request Timeout (seconds)........... 30 
EAP-Identity-Request Max Retries................. 2 
EAP Key-Index for Dynamic WEP.................... 0 
EAP Max-Login Ignore Identity Response........... enable 
EAP-Request Timeout (seconds).................... 30 
EAP-Request Max Retries.......................... 2 



Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide 50 

EAPOL-Key Timeout (milliseconds)...................... 400 
EAPOL-Key Max Retries............................ 4 
EAP-Broadcast Key Interval....................... 3600 

When using 802.1x, the EAP-Request Timeout on the Cisco Wireless LAN Controller should be set to at least 20 seconds. 
In later versions of Cisco Wireless LAN Controller software, the default EAP-Request Timeout was changed from 2 to 30 
seconds. 
For deployments with frequent EAP failures, the EAP-Request Timeout should be reduced to below 30 seconds. 
To change the EAP-Request Timeout on the Cisco Wireless LAN Controller, telnet or SSH to the controller and enter the 
following command. 

(Cisco Controller) >config advanced eap request-timeout 30 
 

When using PSK, it is recommended to reduce the EAPOL-Key Timeout to 400 milliseconds from the default of 1000 
milliseconds and set EAPOL-Key Max Retries to 4 from the default of 2. 
When using 802.1x, the default values for EAPOL-Key Timeout and EAPOL-Key Max Retries should work fine, but it’s 
still recommended to set those values to 400 and 4 respectively. 
The EAPOL-Key Timeout should not exceed 1000 milliseconds (1 second). 
To change the EAPOL-Key Timeout on the Cisco Wireless LAN Controller, telnet or SSH to the controller and enter the 
following command. 

(Cisco Controller) >config advanced eap eapol-key-timeout 400 
 

To change the EAPOL-Key Max Retries on the Cisco Wireless LAN Controller, telnet or SSH to the controller and enter the 
following command. 

(Cisco Controller) >config advanced eap eapol-key-retries 4 
 

Ensure EAP-Broadcast Key Interval is set to a minimum of 3600 seconds (1 hour). 
To change the EAP-Broadcast Key Interval on the Cisco Wireless LAN Controller, telnet or SSH to the controller and enter 
the following command. 

(Cisco Controller) >config advanced eap bcast-key-interval 3600 

Auto-Immune 

The Auto-Immune feature can be enabled optionally for protection against denial of service (DoS) attacks. 
However, enabling this feature may introduce interruptions with voice over wireless LAN. Therefore, it is recommended to 
disable the Auto-Immune feature on the Cisco Wireless LAN Controller. 
To view the Auto-Immune configuration on the Cisco Wireless LAN Controller, telnet or SSH to the controller and enter the 
following command. 

(Cisco Controller) >show wps summary 
Auto-Immune 

Auto-Immune.................................... Disabled 
Client Exclusion Policy 

Excessive 802.11-association failures.......... Enabled 
Excessive 802.11-authentication failures....... Enabled 
Excessive 802.1x-authentication................ Enabled 
IP-theft....................................... Enabled 
Excessive Web authentication failure........... Enabled 

Signature Policy 
Signature Processing........................... Enabled 
 

To disable the Auto-Immune feature on the Cisco Wireless LAN Controller, telnet or SSH to the controller and enter the 
following command. 

(Cisco Controller) >config wps auto-immune disable 
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Rogue Policies 

It is recommended to use the default value (Disable) for Rogue Location Discovery Protocol. 

 

Cisco Catalyst IOS XE Wireless LAN Controller and Lightweight Access Points 

When configuring the Cisco Wireless LAN Controller and Lightweight Access Points, use the following guidelines: 
• Enable 802.11r (FT) 
• CCKM is Disabled. 
• Set Quality of Service (QoS) SSID Policy to Platinum 
• Set the WMM Policy to Required 
• Ensure Session Timeout is enabled and configured correctly 
• Ensure Broadcast Key Interval is enabled and configured correctly 
• Ensure Aironet IE is Disabled 
• Disable P2P (Peer to Peer) Blocking Action 
• Ensure Client Exclusion Timeout is configured correctly 
• Disable DHCP Required 
• Set Protected Management Frame (PMF) to Optional or Required for WPA3 
• Set the DTIM Period to 2 
• Set Load Balance to Disabled 
• Set Band Select to Disabled 
• Set IGMP Snooping to Enabled 
• Configure the Data Rates as necessary 
• Configure RRM as necessary 
• Set EDCA Profile to Voice Optimized or Voice and Video Optimized 
• Ensure that Power Constraint is Disabled 
• Enable Channel Switch Status and Smart DFS 
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• Set Channel Switch Announcement Mode to Quiet 
• Configure the High Throughput data rates as necessary 
• Enable CleanAir 
• Enable Multicast Direct Enable 

802.11 Network Settings 
It is recommended to operate the Cisco Desk Phone 9800 Series only on the 5 GHz band due to the availability of many 
channels and fewer interferers compared to the 2.4 GHz band. 
To use 5 GHz, ensure the 5 GHz Network Status is Enabled. 
Set the Beacon Period to 100 ms. 
It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps and higher as supported (optional) rates. 
However some environments may require 6 Mbps to be enabled as a mandatory (basic) rate. 

 
To use 2.4 GHz, ensure the 2.4 GHz Network Status and 802.11g Network Status are Enabled. 

Set the Beacon Period to 100 ms. 
Short Preamble should be Enabled in the 2.4 GHz radio configuration setting on the access point when there’s no legacy 
clients requiring a long preamble in the wireless LAN. By using the short preamble instead of long preamble, the wireless 
network performance is improved. 
It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps and higher as supported (optional) rates assuming 
that there will not be any 802.11b only clients that will connect to the wireless LAN. However, some environments may 
require 6 Mbps to be enabled as a mandatory (basic) rate. 
If 802.11b clients exist, then 11 Mbps should be set as the mandatory (basic) rate and 12 Mbps and higher as supported 
(optional). 
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High Throughput (802.11n/ac) 

The 802.11n data rates can be configured per radio (2.4 GHz and 5 GHz). 
802.11ac data rates are applicable to 5 GHz only. 
Ensure that WMM is enabled and WPA2/WPA3(AES) is configured to utilize 802.11n/ac data rates. 
The Cisco Desk Phone 9800 Series supports HT MCS 0 – MCS 7 and VHT MCS 0 – MCS 9 1SS data rates only, but higher 
MCS rates can be enabled optionally if there are other 802.11n/ac clients utilizing the same band frequency that include 
MIMO antenna technology, which can take advantage of those higher data rates. 



Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide 54 

 

 

Parameters 

In the EDCA Parameters section, set the EDCA profile to Optimized-voice or Optimized-video-voice for either 5 or 2.4 GHz 
depending on which frequency band is to be utilized. 
In the DFS (802.11h) section, Power Constraint should be left un-configured or set to 0 dB. 
Channel Switch Status and Smart DFS should be Enabled. 
Channel Switch Announcement Mode should be set to Quiet. 
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RRM 

It is recommended to enable automatic assignment method to manage the channel and transmit power settings. 
Configure the access point transmit power level assignment method for either 5 or 2.4 GHz depending on which frequency 
band is to be utilized. 
When using automatic power level assignment, a maximum and minimum power level can be specified. 

 

When using 5 GHz, it’s recommended to limit the number of channels (e.g. 12 channels only) to avoid any potential delay in 
access point discovery caused by scanning many channels. 
 
The 5 GHz channel width can be configured as 20 MHz or 40 MHz for using Cisco 802.11n Access Points and as 20 MHz, 40 
MHz, or 80 MHz for using Cisco 802.11ac Access Points. 
It is recommended to utilize the same channel width for all access points. 
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When using 2.4 GHz, only channels 1, 6, and 11 should be enabled in the channel list. 
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Individual access points can be configured to override the global setting to use dynamic channel and transmit power 
assignment for either 5 or 2.4 GHz depending on which frequency band is to be utilized. 
Other access points can be enabled for automatic assignment method and account for the access points that are statically 
configured. 
This may be necessary if there is an intermittent source of interference in the area. 
The 5 GHz channel width can be configured as 20 MHz or 40 MHz when using Cisco 802.11n Access Points and as 20 MHz, 
40 MHz, or 80 MHz for using Cisco 802.11ac Access Points. 
It is recommended to utilize the same channel width for all access points. 

 

CleanAir 

The Enable CleanAir checkbox should be checked when utilizing Cisco access points with CleanAir technology to detect any 
existing interferers. 
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WLAN Settings 
It is recommended to have a separate SSID for the Cisco Desk Phone 9800 Series. 
you can also use an existing SSID that is configured to support voice capable Cisco Wireless LAN endpoints. 
The SSID to be used by the Cisco Desk Phone Esrepsso can be configured to only apply to a certain 802.11 radio type (e.g. 
802.11a only). 
It is recommended to operate the Cisco Desk Phone 9800 Series on the 5 GHz band only due to availability of many channels 
and fewer interferers compared to the 2.4 GHz band. 
Ensure that the selected SSID is not utilized by any other wireless LANs as that could lead to failures when powering on or 
during roaming; especially when a different security type is utilized. 

 

To utilize 802.11r (FT) for fast secure roaming, set Fast Transition to Enabled. 
Is recommended to uncheck Over the DS to utilize the Over the Air method instead of the Over the Distribution System 
method. 
Protected Management Frame should be set to Optional or Required. 
Enable WPA2/WPA3 policy with AES(CCMP128) encryption then 802.1x, PSK or SAE for authenticated key management 
type depending on whether 802.1x, PSK or SAE is to be utilized. 
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802.11r (FT), PSK or SAE can also be enabled to utilize the same SSID for various type of voice clients, 
depending on whether 802.1x or PSK/SAE is being utilized. 
If using 802.1x, configure the AAA Authentication List that maps to the RADIUS Servers defined in the RADIUS Server 
Groups. 

 

Aironet IE should be Disabled. 
Peer to Peer (P2P) Blocking Action should be Disabled. 
The WMM Policy should be set to Required only when the Cisco Desk Phone 9800 Series or other WMM-enabled phones 
will be using this SSID. 
If there are non-WMM clients existing in the WLAN, it is recommended to put those clients on a separate WLAN. 
If other non-WMM clients must utilize the same SSID as the Cisco Desk Phone 9800 Series, ensure the WMM policy is set to 
Allowed. 
The maximum client connections per WLAN, per AP per WLAN, or per AP radio can be configured as necessary. 
Off Channel Scanning Defer can be tuned to defer scanning for certain queues as well as the scan defer time. 
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It is recommended to enabled defer priority for queues 4-6. 
If using best effort applications frequently or not preserving DSCP values for priority applications (e.g. voice and call control) 
to the access point, it is recommended to enable the lower priority queues (0-3) along with the higher priority queues (4-6) to 
defer off channel scanning as well as potentially increasing the scan defer time. 
For deployments with frequent EAP failures, it is recommended to enable priority queue 7 to defer off channel scanning 
during EAP exchanges. 
Ensure Load Balance and Band Select are disabled. 
Use a DTIM Period of 2 with a beacon period of 100 ms. 
Keep the default settings for 802.11k and 802.11v. 

 

Policy Profiles 

Policy Profiles are used to define additional settings regarding access, QoS, Mobility, and advanced settings. 
Policy Profiles are then mapped to a WLAN Profile via a Policy Tag, which then can be applied to an access point. 
Ensure the Status of the policy profile is Enabled. 
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Select the VLAN or VLAN Group to be utilized with the policy profile. 
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Ensure the QoS SSID Policy is set to Platinum for egress and Platinum-up for ingress. 

 

Configure Session Timeout as desired. It is recommended to enable the session timeout for 86400 seconds to avoid possible 
interruptions during audio calls, and also periodically re-validate client credentials to ensure that the client is using valid 
credentials. 
Configure Client Exclusion Timeout as desired. 
IPv4 DHCP Required should be disabled. 
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RF Profiles 

RF Profiles can be created to specify the frequency bands, data rates, RRM settings, and advanced settings that a group of 
access points should use. 
For the SSID used by the Cisco Desk Phone 9800 Series, it’s recommended to apply to 5 GHz radios only. 
RF Profiles are applied to an RF Tag, which then can be applied to an access point. 
When creating an RF Profile, the Name and Radio Band must be defined. 
Select 5 GHz Band or 2.4 GHz Band for the Radio Band. 

 

On the 802.11 tab, configure the data rates as necessary. 
It is recommended to enable 12 Mbps as Mandatory and 18 Mbps and higher as Supported; however some environments 
may require 6 Mbps to be enabled as a mandatory (basic) rate. 
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On the RRM tab, the Maximum Power Level and Minimum Power Level settings as well as other DCA, TPC, and 
Coverage settings can be configured. 
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On the Advanced tab, Maximum Clients, Multicast Data Rate, Rx Sop Threshold, and other advanced settings can be 
configured. 
It is recommended to use the default value (Auto) for Rx Sop Threshold. 

 

Flex Profiles 

Flex Profiles are used to define the settings the access point should use when in Flexconnect mode. 
Flex Profiles are then mapped to a Site Tag, which then can be applied to an access point. 
Configure the Native VLAN ID for the access point to use as well as the allowed VLANs. 
Ensure ARP Caching is Enabled. 
Enable Local Authentication as necessary. 
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Tags 

Policy Tag 
Policy Tags define the mapping of WLAN Profiles and Policy Profiles. 
Policy Tags are then applied to an access point to specify which WLANs / SSIDs are to be enabled, which interface they 
should be mapped to and which QoS and other settings to use. 
When creating a Policy Tag, click Add, select the WLAN Profile to configure then select the Policy Profile to be used. 

 

Site Tag 
Site Tags define which AP Join Profile and Flex Profile should be used. 
Site Tags are then applied to an access point to specify which AP Join Profile and Flex Profile parameters should be used. 
When creating a Site Tag, click Add, select the AP Join Profile to be used. 
When creating a Site Tag to include a Flex Profile, ensure Enable Local Site is not checked, then select the necessary Flex 
Profile. 
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RF Tag 
RF Tags define which RF Profiles should be used for 2.4 GHz and 5 GHz. 
RF Tags are then applied to an access point to specify which RF Profile parameters should be used. 
When creating a RF Tag, select the 5 GHz Band RF Profile and 2.4 GHz Band RF Profile to be used. 

 

Once tags are defined, they can then be applied to an access point. 

 

If a Site Tag is applied including a configured Flex Profile, then the AP Mode will be changed to Flex automatically. 
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Controller Settings 
Ensure the Default Mobility Domain is configured correctly. 
Enable AP LAG Mode. 
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Mobility Settings 
When multiple Cisco Wireless LAN Controllers are part of the same mobility group, then the IP address and MAC address of 
each Cisco Wireless LAN Controller should be added to the Mobility Peer configuration. 
Ensure each Cisco Wireless LAN Controller is configured with the same Mobility Group Name. 

 

 

Ensure the Mobility MAC Address matches the MAC address of the wireless management interface. 
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Call Admission Control (CAC) 
Unicast Video Redirect and Multicast Direct Enable should be Enabled. 

 

Multicast 
To utilize multicast, Global Wireless Multicast Mode and IGMP Snooping should be Enabled. 

 

 

 

In the Media Stream settings, Multicast Direct Enable should be Enabled. 
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Enable Multicast Direct in the WLAN configuration. 
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Advanced Settings 

Advanced EAP Settings 

To view or configure the EAP parameters, select Configuration > Security > Advanced EAP. 

 

When using 802.1x, the EAP-Request Timeout on the Cisco Wireless LAN Controller should be set to 30 seconds. 
For deployments with frequent EAP failures, the EAP-Request Timeout should be reduced to below 30 seconds. 
If using PSK then it is recommended to reduce the EAPOL-Key Timeout to 400 milliseconds from the default of 1000 
milliseconds with EAPOL-Key Max Retries set to 4 from the default of 2. 
When using 802.1x, the default values for EAPOL-Key Timeout and EAPOL-Key Max Retries should work fine, but it is 
still recommended to set those values to 400 and 4 respectively. 
The EAPOL-Key Timeout should not exceed 1000 milliseconds (1 second). 
Ensure EAP-Broadcast Key Interval is set to a minimum of 3600 seconds (1 hour). 

Rx Sop Threshold 

It is recommended to use the default value (Auto) for Rx Sop Threshold. 

 

Rogue Policies 

It is recommended to use the default value (Disable) for Rogue Location Discovery Protocol. 



Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide 73 

 

Cisco Mobility Express and Lightweight Access Points 

When configuring Cisco Mobility Express and Lightweight Access Points, use the following guidelines: 
• Enable 802.11r (FT) 
• Disable CCKM 
• Set Quality of Service (QoS) to Platinum 
• Ensure 802.11k is Disabled 
• Ensure 802.11v is Disabled 
• Disable P2P (Peer to Peer) Blocking Action 
• Set Client Band Select to Disabled 
• Set Client Load Balancing to Disabled 
• Configure the Data Rates as necessary 
• Configure RF Optimization as necessary 
• Set Traffic Type to Voice and Data 
• Enable CleanAir if utilizing Cisco access points with CleanAir technology 
• Configure Multicast Direct as necessary 

Controller Settings 
Configure one or more of the Mobility Express capable access point’s Operating Mode to include the Controller 
functionality. 
Configure the AP Name and IP settings as necessary. 
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Configure the Cisco Wireless LAN Controller System Name and IP settings as necessary. 

 

802.11 Network Settings 
It is recommended to operate the Cisco Desk Phone 9800 Series only on the 5 GHz band due to the availability of many 
channels and fewer interferers compared to the 2.4 GHz band. 
To use 5 GHz, ensure the 5.0 GHz Band is Enabled. 
It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps and higher as supported (optional) rates. 
However, some environments may require 6 Mbps to be enabled as a mandatory (basic) rate. 
To use 2.4 GHz, ensure the 2.4 GHz Band is Enabled. 
It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps or higher as supported (optional) rates assuming 
that there will not be any 802.11b only clients connected to the wireless LAN. However, some environments may require 6 
Mbps to be enabled as a mandatory (basic) rate. 
If 802.11b clients exist, then 11 Mbps should be set as the mandatory (basic) rate and 12 Mbps or higher as supported 
(optional). 
When using 5 GHz, it’s recommended to limit the number of channels (e.g. 12 channels only) to avoid any potential delay in 
access point discovery caused by scanning many channels. 
The 5 GHz channel width can be configured as 20 MHz or 40 MHz for using Cisco 802.11n Access Points and as 20 MHz, 40 
MHz or 80 MHz for using Cisco 802.11ac Access Points. 
It is recommended to utilize the same channel width for all access points. 
When using 2.4 GHz, only channels 1, 6, and 11 should be enabled in the DCA list. 
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CleanAir detection should be Enabled when utilizing Cisco access points with CleanAir technology to detect any existing 
interference. 

 

RF Optimization 

It is recommended to enable RF Optimization to manage the channel and transmit power settings. 
Set Traffic Type to Voice and Data. 

 

Individual access points can be configured to override the global setting to use dynamic channel and transmit power 
assignment for either 5 or 2.4 GHz depending on which frequency band is to be utilized. 
Other access points can be enabled for automatic assignment method and account for the access points that are statically 
configured. 
This may be necessary if there is an intermittent source of interference in the area. 
The 5 GHz channel width can be configured as 20 MHz or 40 MHz for using Cisco 802.11n Access Points and as 20 MHz, 40 
MHz, or 80 MHz for using Cisco 802.11ac Access Points. 
It is recommended to use channel bonding only when using 5 GHz and utilize the same channel width for all access points. 
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WLAN Settings 
It is recommended to have a separate SSID for the Cisco Desk Phone 9800 Series. 
However, you can also use an existing SSID that is configured to support voice capable Cisco Wireless LAN endpoints. 
The SSID to be used by the Cisco Desk Phone 9800 Series can be configured to only apply to a certain 802.11 radio type (e.g. 
5 GHz only). 
It is recommended to operate the Cisco Desk Phone 9800 Series on the 5 GHz band only due to availability of many channels 
and fewer interferers compared to the 2.4 GHz band. 
Ensure that the selected SSID is not utilized by any other wireless LANs as that could lead to failures when powering on or 
during roaming; especially if a different security type is utilized. 

 

To utilize 802.11r (FT) for fast secure roaming, set Security Type to either WPA2-Enterprise or Personal depending on 
whether 802.1x or PSK/SAE is to be utilized. 
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Set 802.11r to Enable in the Advanced tab of the WLAN configuration.  Ensure Client Band Select and Client Load 
Balancing are disabled. 
802.11k, 802.11r, and 802.11v are not supported, therefore should be disabled. 
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RADIUS Authentication Servers and Account Servers can be configured at a per WLAN level to override the global list. 

 

 

 

 

 

 

 

 

 



Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide 80 

Configure the Native VLAN ID and VLAN ID for the WLAN as necessary. 
Ensure Peer to Peer Block is disabled. 

 

Ensure Platinum (Voice) is selected for QoS. 

 

 

The Maximum Allowed Clients and Maximum Allowed Clients Per AP Radio can be configured as necessary. 
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AP Groups 

AP Groups can be created to specify which WLANs are to be enabled and which interface they should be mapped to as well as 
what RF Profile parameters should be used for the access points assigned to the AP Group. 

 

On the WLANs tab, select the desired WLANs and interfaces to map to then select Add. 
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On the Access Points tab, select the desired access points then select Apply. 
Those access points will then reboot. 

 

On the RF Profile tab, select the desired 2.4GHz or 5GHz RF Profile, then select Apply. 
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RF Profiles 
RF Profiles can be created to specify the frequency bands, data rates, RRM settings, etc. that a group of access points should 
use. 
For the SSID used by the Cisco Desk Phone 9800 Series , it’s recommended to apply it to 5 GHz radios only. 
RF Profiles are applied to an AP group once created. 
When creating an RF Profile, the RF Profile Name and Radio Policy must be defined. 
Select 5GHZ or 2.4GHz for the Radio Policy. 
Maximum clients per radio, Multicast data rates, and Rx Sop Threshold can be configured as necessary. 
It is recommended to use the default value (Auto) for Rx Sop Threshold. 

 

On the 802.11 tab, configure the data rates as necessary. 
Is recommended to enable 12 Mbps as Mandatory and 18 Mbps and higher as Supported. However some environments may 
require 6 Mbps to be enabled as a mandatory (basic) rate. 

 

On the RRM tab, the Channel Width settings and DCA Channels can be configured. 
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Multicast Direct 
In the Media Stream settings, enable Global Multicast and Multicast Direct. 

 

After Multicast Direct is enabled in the Media Stream settings, there will be an option to enable Multicast Direct in the 
Advanced tab of the WLAN configuration. 
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Cisco Autonomous Access Points 

When configuring Cisco Autonomous Access Points, use the following guidelines: 

• Enable 802.11r (FT)  
• Disable CCKM 
• Disable 802.11k  
• Disable 802.11v  
• Configure the Data Rates as necessary 
• Configure Quality of Service (QoS) 
• Set the WMM Policy to Required 
• Disable Aironet Extensions 
• Disable Public Secure Packet Forwarding (PSPF) 
• Set IGMP Snooping to Enabled 

802.11 Network Settings 
It is recommended to operate the Cisco Desk Phone 9800 Series on the 5 GHz band only due to availability of many channels 
and fewer interferers compared to the 2.4 GHz band. 

To use 5 GHz, ensure the 802.11a/n network status is Enabled. 

 

It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps or higher as supported (optional) rates. However, 
some environments may require 6 Mbps to be enabled as a mandatory (basic) rate. 

When using 5 GHz, it is recommended to enable up to 12 channels only to avoid any potential delay in access point discovery 
caused by scanning many channels. 

For Cisco Autonomous Access Points, select Dynamic Frequency Selection (DFS) to use auto channel selection.  

When DFS is enabled, enable at least one band (bands 1-4). 

You can select band 1 only for the access point to use a UNII-1 channel (channel 36, 40, 44, or 48). 

Individual access points can be configured to override the global setting to use dynamic channel and transmit power 
assignment for either 5 or 2.4 GHz depending on which frequency band is to be utilized. 

Other access points can be enabled for Auto RF and workaround the access points that are statically configured. 

This may be necessary if there is an intermittent source of interference in the area. 

The 5 GHz channel width can be configured as 20 MHz or 40 MHz for using Cisco 802.11n Access Points and as 20 MHz, 40 
MHz, or 80 MHz for using Cisco 802.11ac Access Points. 

It is recommended to utilize the same channel width for all access points. 
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Enable Dot11d for World Mode and configure the proper Country Code. 

Ensure Aironet Extensions is disabled. 

Set the Beacon Period to 100 ms and DTIM to 2. 
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To use 2.4 GHz, ensure the 802.11b/g/n network status and 802.11g is enabled. 

It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps or higher as supported (optional) rates assuming 
that there will not be any 802.11b only clients that will connect to the wireless LAN. However, some environments may 
require 6 Mbps to be enabled as a mandatory (basic) rate. 

If 802.11b clients exist, then 11 Mbps should be set as the mandatory (basic) rate and 12 Mbps or higher as supported 
(optional). 
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WLAN Settings 
It is recommended to have a separate SSID for the Cisco Desk Phone 9800 Series. 

However, you can also use an existing SSID that is configured to support voice capable Cisco Wireless LAN endpoints. 

The SSID to be used by the Cisco Desk Phone 9800 Series can be configured to only apply to a certain 802.11 radio type (e.g. 
802.11a only). 

Enable WPA2/WPA3 key management. 

Ensure 11r is enabled for fast secure roaming. 
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Segment wireless voice and data into separate VLANs. 

Ensure that Public Secure Packet Forwarding (PSPF) is not enabled for the voice VLAN, as this would prevent clients from 
communicating directly when associated with the same access point.  Enabling PSPF in this scenario would result in audio 
communication being disrupted. 
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Ensure AES is selected for encryption type. 

 

Configure the RADIUS servers for authentication and accounting. 

 



Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide 92 

Wireless Domain Services (WDS) 

Wireless Domain Services should be utilized in the Cisco Autonomous Access Point environment, which is also required for 
fast secure roaming. 
Select an access point as the primary WDS server and another as the backup WDS server. 
Configure the primary WDS server with the highest priority (e.g. 255) and the backup WDS server with a lower priority (e.g. 
254). 

 

The Cisco Autonomous Access Points utilizes Inter-Access Point Protocol (IAPP), which is a multicast protocol. Therefore, it 
is recommended to a dedicated native VLAN for Cisco Autonomous Access Points. 
For the native VLAN, it is recommended to not use VLAN 1 to ensure that IAPP packets are exchanged successfully. 
Port security should be disabled on switch ports that Cisco Autonomous Access Points are directly connected to. 
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Server groups for Wireless Domain Services must be defined. 
First, define the server group to be used for infrastructure authentication. 
Is recommended to use local RADIUS for infrastructure authentication. 
When not using local RADIUS for infrastructure authentication, ensure that all access points with Wireless Domain Services 
enabled are configured in the RADIUS server. 

 

Then, define the server group to be used for client authentication. 
Ensure that all access points with Wireless Domain Services enabled are configured in the RADIUS server. 
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To utilize local RADIUS for infrastructure authentication, enable all authentication protocols. 
Create a Network Access Server entry for the local access point. 
Define the user account used to configure access points for authentication to the Wireless Domain Services enabled 
access point. 
Configure local RADIUS on each access point participating in Wireless Domain Services. 

 

 

Once the desired access points have been configured successfully to enable Wireless Domain Services, then all access points 
including those serving as WDS servers need to be configured to be able to authenticate to the WDS servers. 
Enable Participate in SWAN Infrastructure. 
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When using a single WDS server, specify the IP address of the WDS server. Otherwise, enable Auto Discovery. 
Enter the Username and Password to authenticate to the WDS server. 

 

Once the access point has been configured to authenticate to the WDS server, you can check WDS Status to view the WDS 
server state as well as how many access points are registered to the WDS server. 
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Call Admission Control (CAC) 
Disabled. 

QoS Policies 
Configure the following QoS policy on the Cisco Autonomous Access Point to enable DSCP to CoS (WMM UP) mapping.  

This allows packets to be placed into the proper queue as long as those packets are marked correctly when received at the 
access point level. 
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To enable QBSS, select Enable and check Dot11e. 

If Dot11e is checked, then both CCA versions (802.11e and Cisco version 2) will be enabled. 

Ensure IGMP Snooping is enabled. 

Ensure Wi-Fi MultiMedia (WMM) is enabled. 

 

If you enable the Stream feature either directly or via selecting Optimized Voice for the radio access category in the QoS 
configuration section, then use the default settings. These defaults include enabling 5.5, 6, 11, 12 and 24 Mbps as nominal 
rates for 802.11b/g, 6, 12, and 24 Mbps for 802.11a and 6.5, 13, and 26 Mbps for 802.11n. 

If the Stream feature is enabled, ensure that only voice packets are placed into the voice queue.  Signaling packets (SIP) 
should be placed into a separate queue. This can be achieved by setting up a QoS policy mapping the DSCP to the correct 
queue. 
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Power Management 
Proxy ARP helps answer any ARP requests on behalf of the device. 
To enable Proxy ARP, set Client ARP Caching to Enable. 
Also ensure that Forward ARP Requests To Radio Interfaces When Not All Client IP Addresses Are Known is checked. 

 

Cisco Meraki Access Points 

When configuring Cisco Meraki access points, use the following guidelines: 
• Enable 802.11r for WPA2/WPA3-Enterprise or Pre-shared key 
• Set Splash page to None 
• Enable Bridge mode 
• Enable VLAN tagging 
• Set Band selection to 5 GHz band only 
• Configure the Data Rates as necessary 
• Configure Quality of Service (QoS) 

Creating the Wireless Network 
A wireless network must be created prior to adding any Cisco Meraki access points to provide WLAN service. 
Select Create a new network from the drop-down menu. 
Select Wireless for Network type then click Create. 
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Cisco Meraki access points can be claimed either by specifying the serial number or order number. 
Once claimed, those Cisco Meraki access points will then be listed in the available inventory. 
Cisco Meraki access points can be claimed by selecting Add Devices on either the Create network or Organization > 
Configure > Inventory pages. 
Access points can also be claimed by selecting Add APs on the Wireless > Monitor > Access points page, then selecting 
Claim. 

 
Once claimed, Cisco Meraki access points can be added to the desired wireless network via the Organization > Configure > 
Inventory page. 
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Claimed access points can also be added to a wireless network by selecting Add APs on the Wireless > Monitor > Access 
points page. 

 

SSID Configuration 
To create an SSID, select the desired network from the drop-down menu then select Wireless > Configure > SSIDs. 
It is recommended to have a separate SSID for the Cisco Desk Phone 9800 Series. Data clients and other type of clients should 
utilize a different SSID and VLAN. 
However, you can also use an existing SSID that is configured to support voice capable Cisco Wireless LAN. 
To set the SSID name, select Rename. 
To enable the SSID, select Enabled from the drop-down menu. 
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On the Wireless > Configure > Access control page, select WPA2-Enterprise to enable 802.1x authentication. 
The Cisco Meraki authentication server or an external RADIUS server can be utilized when selecting WPA2-Enterprise. 
The Cisco Meraki authentication server supports PEAP authentication and requires a valid email address. 
Other authentication types (e.g. Pre-Shared Key) are available as well. 
Ensure 802.11r is enabled 
Ensure Splash page is set to None to enable direct access. 

 
If WPA2-Enterprise is enabled where the Cisco Meraki authentication server will be utilized as the RADIUS server, then a 
user account must be created on the Network-wide > Configure > Users page, which the Cisco Desk Phone 9800 Series will 
be configured to use for 802.1x authentication. 
Note: Cisco Meraki access points do not support EAP-FAST. 
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On the Wireless > Configure > Access control page, it’s recommended to enable Bridge mode. This configuration allows 
the Cisco Desk Phone 9800 Series to obtain DHCP from the local LAN instead of the Cisco Meraki network, unless call 
control, other endpoints, etc. are cloud-based. 
Once Bridge mode is enabled, the VLAN tagging option will be available. 
It is recommended to enable VLAN tagging for the SSID. 
If VLAN tagging is utilized, ensure that the Cisco Meraki access point is connected to a switch port configured for trunk mode 
allowing that VLAN. 
For more information about Cisco Meraki MS Switches, refer to the Cisco Meraki MS Switch VoIP Deployment Guide. 
https://meraki.cisco.com/lib/pdf/meraki_whitepaper_msvoip.pdf 
when utilizing Cisco IOS Switches, use the following switch port configuration for ports that have Cisco Meraki access points 
connected to enable 802.1q trunking. 

Interface GigabitEthernet X 
switchport trunk encapsulation dot1q 
switchport mode trunk 
mls qos trust dscp 

 
On the Wireless > Configure > Access control page, you can configure the frequency band for the SSID to be used by the 
Cisco Desk Phone 9800 Series as needed. 
It is recommended to select 5 GHz band only to operate the Cisco Desk Phone 9800 Series on the 5 GHz band due to 
availability of many channels and fewer interferers compared to the 2.4 GHz band. 
If the 2.4 GHz band needs to be used due to increased distance, then Dual band operation (2.4 GHz and 5 GHz) should be 
selected. Do not utilize the Dual band operation with Band Steering option. 
Is recommended to disable data rates below 12 Mbps unless a legacy 2.4 GHz client needs to connect to the Wireless LAN. 
Cisco Meraki access points currently utilize a DTIM period of 1 with a beacon period of 100 ms. These settings are non-
configurable. 
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On the Wireless > Configure > SSID availability page, the SSID can be broadcasted by setting Visibility to Advertise this 
SSID publicly. 
Is recommended to set Per-AP Availability to This SSID is enabled on all APs. 
A schedule for SSID availability can be configured as needed. However, it is recommended to set Scheduled Availability to 
Disabled. 

 

Radio Settings 
On the Wireless > Configure > Radio settings page, access points can be configured in bulk or individually to define the 
automatic or manual channel and transmit power settings. 
When using Cisco Meraki access points, it is recommended to select Auto for the channel and transmit power to utilize what is 
defined in the RF Profile. 
However, individual access points can be configured with static channel and transmit power for either 5 or 2.4 GHz radios. 
This configuration may be necessary if there is intermittent interference in the area. While other access points can be enabled 
for Auto and work around the access points that are have static channel assignments. 
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It is recommended to either modify the standard Basic Indoor Profile or create a new RF Profile with Band selection set to 
Per SSID and Client balancing set to Off. 

 

 
In the RF Profile, the Channel width for 5 GHz radios can be set to use 20 MHz, 40 MHz, or 80 MHz channels. 
2.4 GHz radios utilize 20 MHz channel width and cannot be configured for any other channel width. 
It is recommended to utilize the same channel width for all access points. 
5 GHz channels to be used by AutoChannel can also be configured in the RF Profile. 
2.4 GHz channels used by AutoChannel are limited to channels 1, 6, and 11 only. 
The Radio transmit power range is also be configured in the RF Profile. 
If the Minimum bitrate configuration is set to Per band, then it will override what is defined in the SSID configuration. 
It is recommended to disable data rates below 12 Mbps unless a legacy 2.4 GHz client needs to be able to connect to the 
Wireless LAN. 
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Firewall and Traffic Shaping 
On the Wireless > Configure > Firewall & traffic shaping page, firewall and traffic shaping rules can be defined. 
Ensure a Layer 3 firewall rule is configured to allow local LAN access for wireless clients. 
To allow traffic shaping rules to be defined select Shape traffic on this SSID in the drop-down menu for Shape traffic. 
Once Shape traffic on this SSID has been applied, then select Create a new rule to define Traffic shaping rules. 
By default, Cisco Meraki access points currently tag voice frames marked with DSCP EF (46) as WMM UP 5 instead of 
WMM 
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UP 6 and call control frames marked with DSCP CS3 (24) as WMM UP 3 instead of WMM UP 4. 
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Configure Cisco Call Control 

Cisco Webex Calling 

You can add Cisco Desk Phone 9800 Series to Cisco Webex Calling and assigned it to a user for personal usage or as a 
workspace for shared usage. 

Personal Usage 
You can assign Cisco Desk Phone 9800 Series to a user and configure the settings in on Control Hub.  

 

 

Workspace Usage 
You can configure Cisco Desk Phone 9800 Series as a workspace device on Control Hub. 
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Wi-Fi Capability 
On Cisco Control Hub, ensure that Wi-Fi is enabled to use a Cisco Desk Phone 9800 Series in wireless environment. 

 

Cisco Unified Communications Manager 

Cisco Unified Communications Manager offers different phone, calling, and security features. 

Device Enablement 
To enable the Cisco Desk Phone 9800 Series device type in the Cisco Unified Communications Manager, the corresponding 
device package COP file must be installed via the Cisco Unified Operating System Administration webpage for each Cisco 
Unified Communications Manager server. 
Each Cisco Unified Communication Manager node may not have to be restarted after the device package COP file has been 
installed. 
Perform the following actions based on the Cisco Unified Communications Manager version. 

12.5(1) and higher 
• Restart the Cisco Tomcat service on all Cisco Unified Communications Manager nodes. 
• If running the Cisco CallManager service on the publisher node, restart the service on the publisher node 
only. 
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Note: The Cisco CallManager Service on subscriber nodes do not need to be restarted. 

For information on how to install COP file, refer to the Cisco Unified Communication Manager Operation System 
Administration Guide at this URL: 

https://www.cisco.com/c/en/us/support/unified-communications/unified-communications-manager-
callmanager/productsmaintenance-guides-list.html 
When adding the Cisco Desk Phone 9800 Series to the Cisco Unified Communications Manager, it must be provisioned using 
the Ethernet MAC address as the Wireless LAN MAC is used for Wi-Fi connectivity only. 
The Ethernet MAC address of the Cisco Desk Phone 9800 Series can be found by navigating to Settings > About this device 
on the phone. 

 

Common Settings 
Some settings such as Wireless LAN can be configured on an enterprise phone through common phone profile or at individual 
phone level. 
Wireless LAN is automatically disabled temporarily when Ethernet is connected to the Cisco Desk Phone 9800 Series and will 
be automatically re-enabled once Ethernet is disconnected if Wi-Fi is enabled on the phone. 
Override common settings can be enabled at either configuration level. 
 

 

QoS Parameters 
The DSCP values for SIP communications, phone configuration, and phone-based services are defined in the Cisco Unified 
Communications Manager’s Enterprise Parameters. 
The default DSCP value for SIP communications and phone configuration is set to CS3. 
Phone-based services are configured to be best effort traffic by default. 
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Wireless LAN Profiles 
With Cisco Unified Communications Manager 10.0 release and later, you can provision the Cisco Desk Phone 9800 Series 
with Wireless LAN Profiles. EAP-TLS support is included. 

Create a Wirless LAN Profile 

Follow the following steps to provision your phone with a Wireless LAN profile on Cisco Unified Communications Manager. 
o Before creating a Wireless LAN Profile and associating it with your phone, the phone should be configured to 

utilize a security profile with TFTP encryption enabled. This prevents Wireless LAN Profile data from being 
transmitted in clear text to the phone. 
 

 
 

o Once the security profile has been created, it must be applied to the phone to enable TFTP encryption for the 
phone’s configuration files. 

o Select the configured security profile from the Device Security Profile drop-down menu. 

 
 

1. To create a Wireless LAN Profile, navigate to Device > Device Settings > Wireless LAN Profile within the 
Cisco Unified Communications Manager’s Administration interface. 

2. From the Wireless LAN Profile page, select Add New. 
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3. Specify the Name, Description, Wireless Settings (SSID, Frequency Band, User Modifiable), and 
Authentication Settings for the profile. 
Below are Wireless LAN Profile defaults: 

• Frequency Band = Auto 
• User Modifiable = Allowed 
• Authentication Method = EAP-FAST 

 
 

• Enter a Name for the Wireless LAN Profile containing up to 50 characters. 
• Optionally, enter the Description containing up to 63 characters. 

 

 
 

• Select Allowed in the User Modifiable drop-down list.  
The user has the capability to change any Wireless LAN settings (e.g. Enable/Disable, SSID, Frequency 
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Band, Authentication Method, Username and Password, PSK Passphrase, WEP Key) locally on the endpoint. 
 
Note: For Cisco Desk Phone 9800 Series, users are allowed to change the WLAN settings regardless of this 
parameter. 
 

 
 
 

• Enter an SSID containing up to 32 ASCII characters. 

 
 

• Select the desired Frequency Band option. 
• Auto = Gives preference to 5 GHz channels, but operates on both 5 GHz and 2.4 GHz channels 
• 2.4 GHz = Operates on 2.4 GHz channels only 
• 5 GHz = Operates on 5 GHz channels only 
 

 
 

• Select the desired Authentication Method option. 
• If EAP-FAST, PEAP-MSCHAPv2, or PEAP-GTC is selected, the option to enter shared credentials 
(Username and Password) is available. 
• If Provide Shared Credentials is not checked, the Username and Password will need to be configured 
locally on the phone by the admin or user. 
 

 

 

 
 

• If Provide Shared Credentials is checked, then the specified Username and Password will be utilized for 
all Cisco Desk Phone 9800 Series that utilize this Wireless LAN Profile. 
• Up to 64 characters can be entered for the Username and Password. 
• Optionally enter the Password Description. 
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• If EAP-TLS is selected, User Certificate must be configured to specify the type of user certificate to utilize 
for EAP-TLS authentication. 
• Set User Certificate to MIC (Manufacturing Installed Certificate), LSC (Locally Significant Certicate) or 
User Installed. 

 

 
• If PSK is selected to utilize Pre-Shared Key authentication, a PSK Passphrase must be entered. 
The PSK Passphrase must be in one of the following formats: 

• 8-63 ASCII character string 
• 64 HEX character string 

• A Password Description can optionally be entered. 

 
• If None is selected, then no authentication is required, and no encryption will be utilized. 
 

 
 
 Note: Cisco Desk Phone 9800 Series doesn’t support WEP or LSC ECC certificate. 
 

• The Cisco Desk Phone 9800 Series does not support the Network Access Profile option. 
 

• Select Save once the Wireless LAN Profile configuration is complete. 
 
 

Create a Wirless LAN Profile Group 

1. To create a Wireless LAN Profile Group, navigate to Device > Device Settings > Wireless LAN Profile Group 
within the Cisco Unified Communications Manager’s Administration interface. 

2. From the Wireless LAN Profile Group page, select Add New. 
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3. Specify the Name, Description, and select the Wireless LAN Profile to add. 

 

 
 

Note: Only one Wireless LAN Profile should be added to a Wireless LAN Profile Group. 
4.  Select Save once the Wireless LAN Profile Group configuration is complete. 

 

 

Apply a Wireless LAN Profile Group to a Device Pool 

Once the Wireless LAN Profile Group has been created, it can be applied to a Device Pool or an individual 
phone. 

1. To apply a Wireless LAN Profile Group to a device pool, navigate to System > Device Pool in the Cisco Unified 
Communications Manager’s Administration interface. 

2. If you want to apply the WLAN profile to an existing device pool, do the following actions:  
a. Find the device pool and open it. 
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b. In the Roaming Sensitive Settings section, select your WLAN profile in the Wireless LAN Profile Group list. 
 

 
c. Select Save. 
d. Select Apply Config. 

3. If you want to apply the WLAN profile to a new device pool, do the following actions: 
a. Select Add New to create a Device. 
b. Specify the name and the required information. 
c. In the Roaming Sensitive Settings section, select your WLAN profile in the Wireless LAN Profile Group list. 
d. Select Save. 
e. Select Apply Config. 
f. Go to Device > Phone, and find your phone that you want to add to the device pool. 
g. In the Device Information section, select the device pool that you created in the Device Pool drop-down list. 

 

 
 

h. Select Save. 
i. Select Apply Config. 
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Apply a Wireless LAN Profile Group to an Individual Phone 

1. Navigate to Device > Phone in the Cisco Unified Communications Manager’s Administration interface. 
2. Find your phone and open the Phone Configuration page. 
3. In the Device Information section, select your WLAN profile group in the Wireless LAN Profile Group drop-

down list. 
4. Select Save. 
5. Select Apply Config. 
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Configure the Cisco Desk Phone 9800 Series 

Automatic Provisioning 

This method is currently available only for phones registered to Cisco Unified Communications Manager.  For automatic 
provisioning of the Wi-Fi Profiles, the Cisco Desk Phone 9800 Series needs to be connected to a network via Ethernet or via 
Wi-Fi, which has connectivity to the Cisco Unified Communications Manager. 
With connectivity to a Cisco Unified Communications Manager 10.0 or later, Wi-Fi profile configuration data can be 
downloaded and applied to the Cisco Desk Phone 9800 Series. 
Cisco Unified Communications Manager 11.0 or later is required to download and apply a Wi-Fi profile including EAP-TLS 
authentication. 
For more information, see the Cisco Unified Communications Manager > Wireless LAN Profiles section. 
Certificates can also be automatically installed upon a network connection. 
For more information, see the Simplified Certificate Enrollment Protocol (SCEP) section. 

Config/Modify Wi-Fi Profile via Phone Web Portal 

Ensure that your Cisco Desk Phone 9800 Series has got a valid IP address either by wired or wireless connection.  

Note: The phone web portal is available only for phones registered to Webex Calling or Cisco BroadWorks.  

1. Enter the IP address of the phone in your web browser address bar. 
For example, http://10.64.84.147/ 

2. Click Admin Login and then click advanced to access the configurations as an administrator. 
3. Go to Voice > System. 
4. Set Phone-wifi-on to Yes to turn on Wi-Fi on the phone. 
5. Specify the Wi-Fi network name and credentials for the phone to connect to the wireless access point. 

The Security Mode can be any of the following depending on the settings on your access point. 

• If Auto, EAP-FAST, or PEAP is selected then Wi-Fi User ID and Wi-Fi Password are required. 
• If PSK is selected to utilize Pre-Shared Key authentication, then a PSK Password must be entered. 

The PSK Password must be 8-63 ASCII character string. 

• If WEP is selected to utilize static WEP (Wired Equivalent Privacy) authentication, then a WEP Key must be 
entered. 

• If None is selected, then no authentication is required and no encryption will be utilized. 
• If Auto is selected, the phone could dynamically choose EAP-FAST or EAP-PEAP as authentication method 

based on communication with target AP. 
• If EAP-TLS is selected, currently only MIC certificate is supported for phones registered to Webex Calling/ 

Webex DI/Broadworks. 

Select the desired Frequency Band: 

• Auto: Gives preference to 5 GHz channels, but operates on both 5 GHz and 2.4 GHz channels 
• 2.4 GHz: Operates on 2.4 GHz channels only 
• 5 GHz: Operates on 5 GHz channels only 

 

http://10.64.84.147/
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6. Click Submit All Changes. 

 

You can go to the Info > Status tab to view the network status. 

 

Notes:  

• The phone reboots when switching from an access point to another.. 
• When the phone is connected via Ethernet connection, Wi-Fi is turned off.  When the Ethernet cable is 

unplugged, the phone connects to the wireless network automatically if properly configured. 
• The Wi-Fi settings are synchronized to the settings in the phone Settings menu. 

Configure Wi-Fi Settings on the Phone UI 

1. Press Settings . 
2. If prompted, enter the password to access the Settings menu.  
3. Navigate to Network and service > Network settings. 
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4. If Wi-Fi status is Off, turn on Wi-Fi. The phone starts scanning available wireless network. 
 

  
9861 9871 

 
5. If you are using a 9861 phone, press Select to open the Connect to Wi-Fi screen. If you are on a 9871 phone, go 

to the next step. 
6. Select your access point from the available networks and enter your credentials if the network requires 

authentication. 
The security mode and available frequency bands depends on the settings of the access point. 
If the network is 802.1x-enabled, the phone will dynamically select Auto for the EAP type, which is determined 
by the RADIUS server configuration. You can select the inner authentication method.  
 

 
 

7. Select Apply. 
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Join a Hidden Wireless Network 

1. Press Settings . 
2. If prompted, enter the password to access the Settings menu.  
3. Navigate to Network and service > Network settings. 
4. If Wi-Fi status is Off, turn on Wi-Fi. 
5. Select Wi-Fi and then select Join other network . 
6. Enter the network name, select the security mode, and enter the credentials.  

  

9861 9871 

Ensure that you select the proper security mode based on the settings of the access point. 

• None: Select this option if the wireless network to connect is an open network. No password is needed. 
• PSK: If your network is secured with Pre-Shared Key or WPA3-SAE, select this option and enter the 

password. Pre-Shared Key length is 8~~63 bytes. 
• Auto/EAP-FAST/EAP-PEAP: When you select any of these options, user ID and password are 

required. 
• EAP-TLS: When you select this option, the user certificate type is required. Currently, only 

Manufacturing installed certificate (MIC) is supported.  
Note: Certificate Management and root CA install is currently available only with Webex 
Calling/DI/Broadwork. 

7. Select Apply. 
 

    

Delete a Connected Network 
User can delete the currently connected AP in the Settings menu. 
 

1. In the Network settings screen, select the access point that the phone is connected to. 
2. Select Forget or Forget this network depending on your phone model. 
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Certificate Management 

The Cisco Desk Phone 9800 Series can utilize X.509 digital certificates for EAP-TLS or to enable Server Validation. 
A User Certificate can be installed either automatically via Simple Certificate Enrollment Protocol (SCEP) or manually via the 
phone’s admin webpage interface (https://<phone_IP_address>:8443). 
Only one certificate per certificate type is allowed; 1 User Certificate and 1 Server Certificate (either via SCEP or manual 
method). 
LSC certificate is installed by CUCM CAPF service. 
Once a certificate is installed, Server Validation is automatically enabled if configured for EAP-TLS 
Microsoft® Certificate Authority (CA) servers are recommended. Other CA server types may not be completely interoperable 
with the Cisco Desk Phone 9800 Series. 
Both DER and Base-64 (PEM) encoding are acceptable for the client and server certificates. 
Certificates with a key size of 1024, 2048, and 4096 are supported. 
Ensure the client and server certificates are signed using either the SHA-1 or SHA-2 algorithm, as the SHA-3 signature 
algorithms are not supported. 
Ensure Client Authentication is listed in the Enhanced Key Usage section of the user certificate details. 

Manual Installation 
Ensure that the admin webpage interface is Enabled, the username is admin, and the Admin password is configured by 
CUCM.  

 
Open manual install page via https://x.x.x.x:8443 

 
You can utilize either the internal Manufacturing Installed Certificate (MIC), LSC or a custom User Installed certificate as the 
User Certificate for EAP-TLS. 

Manufacturing Installed Certificate (MIC) 

The pre-installed Manufacturing Installed Certificate (MIC) can be used as the User Certificate for EAP-TLS. 
The MIC’s CA chain must be exported and added to the RADIUS server’s trust list to use the MIC as the User Certificate for 
EAP-TLS. 
Click Export to download the root and sub CA certificates from the admin webpage interface. 

 
This root CA should added to Radius server's trust list. 

User Installed Certificate 

To manually install a user certificate for EAP-TLS, select Install for User Installed on the main Certificates webpage. 
Select Browse to point to the user certificate in PKCS #12 format (.p12 or .pfx). 
Enter the Extract password, then select Upload. 
Ensure the CA chain that issued the user certificate is added to the RADIUS server’s trust list. 
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Will need to restart the Cisco Desk Phone 9800 Series after all certificates are installed. 

 

LSC Certificate 

Enable CAPF service on CUCM. 
1. Login to Cisco Unified CM Administration. 
2. Enter System -> Service Parameters. 
3. Select your CUCM server. 
4. Select Cisco Certificate Authority Proxy Function. 
5. Select certificate issuer in Certificate Issuer to Endpoint. 
6. If Online CA is selected, you should configure the external CA in Online CA Parameters. 
7. If Cisco Certificate Authority Proxy Function is selected, the build-in CAPF function is used. 
8. Click Save button. 
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Active or restart CAPF server 

1. Login Cisco Unified Serviceability. 
2. Enter Tools -> Service Activation. 
3. Select your CUCM server. 
4. Ensure that Cisco Certificate Authority Proxy Function is Activated. 
5. Enter Tools -> Control center Feature Service. 
6. Choose and restart Cisco Certificate Authority Proxy Function. 

 
Install LSC certificate to Cisco Desk Phone 9800 Series 

1. Login to Cisco Unified CM Administration. 
2. Enter Device -> Phone, then enter the profile page of your device. 
3. Select Install/Upgrade in Certificate Operation, then Save and Apply. 
4. The phone will install the LSC and reboot. 

 

 
 

Check Phone LSC status via Settings > Network and services > Security settings 

 

 



Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide 124 

Import CAPF CA to ISE. 

Export LSC CA cert from CUCM. 
If Online CAPF is used, user should ask external CA cert from admin.  If build-in CAPF is used, user can download CA cert 
from CUCM. 

1. Login to Cisco Unified OS Administration 
2. Enter Security -> Certificate Management 
3. Download the CAPF Identity certificate 

 
Import LSC certificate to trust list. 
Ensure that the CA chain of LSC certificate is added to the RADIUS server’s trust list. 

 

Server Certificate 
The root CA certificate that issued the RADIUS server’s certificate must be installed for EAP-TLS or to enable Server 
Validation.  Service Validation is optional.  If user doesn't want it, this step could be dropped. 
To manually install a server certificate, select Install for Authentication Server CA on the main Certificates webpage. 
Select Browse to point to the server certificate with PEM (Base-64) or DER encoding. 

 
Will need to restart the Cisco Desk Phone 9800 Series after all certificates are installed. 

 
 

Certificate Removal 
User Installed Certificates can be removed via the admin webpage interface. To remove a certificate via the admin webpage, 
select Delete for the corresponding certificate, then restart the phone once a certificate has been removed. 
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LSC certificate could be removed on CUCM phone page, then Save and Apply. 

 

Simple Certificate Enrollment Protocol (SCEP) 
SCEP is the standard for automatically provisioning and renewing certificates avoiding manual installation and re-installation 
of certificates on clients. 
A Cisco IOS Registration Agent (RA) (e.g. Cisco IOS router) can serve as a proxy (e.g. SCEP RA) to the SCEP enabled CA 
that is to issue certificates.  Topology is like following picture shows. 

 
Ensure that the same CA chain is used for issuing certificates to the phones as well as for the RADIUS servers; otherwise 
server validation could fail. 
For initial certificate enrollment via SCEP, the Cisco Desk Phone 9800 Series needs to be connected to an Ethernet network 
which has connectivity to the Cisco Unified Communications Manager. 
The Cisco Desk Phone 9800 Series utilizes the following parameters defined in Cisco Unified Communications Manager for 
SCEP requests. 
The WLAN SCEP Server must be configured to include either the IP address or hostname of the SCEP RA. 
The WLAN Root CA Fingerprint (SHA256 or SHA1) must be configured to include the fingerprint of the CA that issuing 
the certificates. If the issuing CA in which the SCEP RA is enrolled to is a subordinate CA, then enter its fingerprint but not 
the fingerprint of the root CA. The defined fingerprint is used to validate the received certificate. 
Removing these parameters will disable SCEP. 
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The Cisco Desk Phone 9800 Series then sends a SCEP enroll request to the SCEP RA including the phone’s Manufacturing 
Installed Certificate (MIC) as the Proof of Identity (POI). 
The SCEP RA validates the phone’s MIC using the certificate of the subordinate CA that issued the phone’s MIC, then passes 
it to the RADIUS server for further device authentication. 
The RADIUS server validates the device and sends a response to the SCEP RA. 
The SCEP RA then forwards the enroll request to the CA if RADIUS authentication was successful. 
The SCEP RA receives the user certificate from the CA and sends it to the phone after it receives a poll request from the 
phone. 
The Cisco Desk Phone 9800 Series will periodically check the user and server certificate expiration periods. 
Certificate renewal will occur every 24 hours until successful when the expiration date is within 50 days. 
If the CA certificate used to define the WLAN Root CA Fingerprint (SHA256 or SHA1) has expired, then the phone will send 
a SCEP getca request for a new CA certificate, but the admin would need to update the fingerprint in the phone’s configuration 
within Cisco Unified Communication Manager to match the new CA certificate prior so it can be successfully validated. The 
old CA certificate will then be removed if the new one is successfully received from the CA. 
If the user certificate has expired, the phone will send a new SCEP enroll request to update the user certificate. The old user 
certificate will then be removed if a new user certificate is successfully received from the CA. 
If the WLAN SCEP Server or WLAN Root CA Fingerprint (SHA256 or SHA1) has been modified, then the Cisco Desk 
Phone 9800 Series will attempt to update the CA and user certs immediately. 

Certificate Authority (CA) Configuration 

It’s recommended to use Microsoft® Certificate Authority (CA) servers. 
Use the following guidelines to configure the Microsoft CA. 

1. Create Certificate Authority and Active Directory Domain Service on Microsoft Windows server. 
2. Enable Network Device Enrollment Service. 
3. Make Administrator a member of IIS_IUSERS group by going to MemberOf tab of user property screen. 
4. Launch Server Manager, then click Add roles. 

 
5. On the Select Server Role page, select the Active Directory Certificate Services role, then click Next.  The 

default service selected is the Certification Authority, clear the check box, and then go to 
6. Add the Network Device Enrollment Service role service. 
7. In the Add Roles Wizard, on the Select Role Services page, select the Network Device Enrollment Service 

check box, then click Next. 
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8. The wizard will detect whether all the required dependencies are installed. If any dependencies are missing, you 

will be prompted with a dialog box explaining what is missing and requesting your permission to install the 
dependencies. Click Yes to continue the installation. 

9. Click User Account under Role Services and then click Select User…. 

 
10. Type in Administrator as the user name, then enter the password. 
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11. Enter the Registration Authority information. 

 
12. Select Microsoft Strong Cryptographic Provider for Signature Key CSP and Encryption key CSP. 
13. Select 2048 for Key character length. 

 
14. Select Install. 

 
A confirmation page will be displayed if the installation was successful. 
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15. Disable SCEP enrollment challenge password requirement via regedit by setting EnforcePassword to 0. 

(HKEY_LOCAL_MACHINE > SOFTWARE > Microsoft > Cryptography > MSCEP > EnforcePassword) 

 
16. Specify certificate templates for SCEP 

SCEP uses the certificate template that is set in the registry for issuing certificates. 
(HKEY_LOCAL_MACHINE > SOFTWARE > Microsoft > Cryptography > MSCEP) 

 
Typically the RA will have a longer period (same as that of the CA certificate). The default template used for RA 
to be enrolled to the SCP server is IPSECIntermediateOffline as highlighted above. So make sure a correct 
template is set to the above registries before enrolling Cisco RA to the SCEP server. 
After the Cisco RA is enrolled to the SCEP server, admin needs to change the template in the registry (if the user 
certificate period needs to be shorter than that of the root CA). 

17. Right click Certificate Templates then select Manage. 
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18. Right click User template then select Duplicate Template. 
19. Select Windows Server 2003 2008 Template. 
20. Under the General tab, change template name and validity period. 
21. Under the Extensions tab, ensure the following: 

Client Authentication is set as one of the application policies 
Key Usage has Digital Signature attribute 

 
22. Configure the Validity Period on the General tab as necessary. 
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23. Configure Subject Name tab as shown below. 

 
24. Configure Extensions tab as shown below. 

 
25. Configure Algorithm Name, Minimum Key Size, and Request Hash as necessary on the Cryptography tab. 
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26. Enable the newly created template by right clicking Certificate Templates then selecting New > Certificate 
Template to Issue. 

 
27. Select SCEP User template. 

 
28. Associate the newly created template to SCEP via regedit. 

 
29. Go to IIS > Application Pools to restart the SCEP service for the new template to take effect. 

 

RADIUS Configuration 

Use the following guidelines to configure the RADIUS server.  ISE server plays a role of SCEP device authentication for 
enrollment, and it can be used for the PKI integration with Cisco IOS RA for SCEP solution. 
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1. Navigate to Administration > Network Device Profiles, add a new profile or levering existing profile Cisco.  If 
create a new profile, remember to configure Supported Protocols, Authentication/Authorization and 
Permission properly. 

 
 

 
2. Navigate to Administration > Network Resources > Network Devices and add a device for Cisco IOS RA like 

yan_RA_sudi as shown bellow 

 
3. Navigate to Policy > Authentication, set a Default rule to use Default Network Access and use 

All_Uesr_ID_Stores. 



Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide 134 

 

 
The authentication options can be set to continue for “If authentication failed” or “If user not found” since 
certificate based authentication has already been done in Cisco IOS RA. 

 
4. Navigate to Administration > Identity Management > Identity Source Sequence. 

 
5. Under Policy > Policy Elements > Results > Authentication > Allowed Protocols, edit Default Network 

Access as shown below 
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6. Under Policy > Policy Elements > Results > Authorization > Authorization Profiles, add a profile for SCEP 

(e.g. Phone_SCEP_profile)  
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7. Navigate to Administration > Identity Management > Groups > User Identity Groups and add a user group 

for SCEP, like scep-group displayed in below picture. 

 
8. Navigate to Policy > Authorization Policy and add a SCEP authorization policy by clicking the down arrow 

beside Edit of an existing policy and selecting Insert new rule above. 
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9. Navigate to Administration > Identities > Users and create user accounts for Cisco Desk Phone 9800 Series.  

The user name has the format of serialNumber (e.g. PID:DP-9861 SN:FCH27472020). 
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SCEP RA Configuration 

Currently only a Cisco IOS router running IOS version 15.1(4)M10 or later is supported as the SCEP RA. 
Use the following guidelines to configure a Cisco IOS router as a SCEP RA. 
• Enable HTTP server on the Cisco IOS router. 

ISR_RA# configure terminal 
ISR_RA(config)# ip http server 
ISR_RA(config)# exit 

• Configure a RADIUS server for device authentication. 
ISR_RA# configure terminal 
ISR_RA(config)# radius server MyRadius 
ISR_RA(config-radius-server)# address ipv4 10.195.19.63 auth-port 1812 acct-port 1813 
ISR_RA(config-radius-server)# key <REMOVED> 
ISR_RA(config-radius-server)# exit 
ISR_RA(config)# aaa authorization network PhoneList group radius 
ISR_RA(config)# exit 

• Configure a PKI trustpoint for the MIC’s CA chain to validate the phone’s MIC. 
ISR_RA# configure terminal 
ISR_RA(config)# crypto pki trustpoint MIC_trustpoint 
ISR_RA(ca-trustpoint)# authorization list PhoneList 
ISR_RA(ca-trustpoint)# authorization username subjectname commonname 
ISR_RA(ca-trustpoint)# exit 
ISR_RA(config)# crypto pki trustpoint MIC_trustpoint 
ISR_RA(ca-trustpoint)# enrollment terminal 
ISR_RA(ca-trustpoint)# revocation-check none 
ISR_RA(ca-trustpoint)# exit 
ISR_RA(config)# crypto pki authenticate MIC_trustpoint 
Enter the base 64 encoded Manufacturing CA certificate. End with a blank line or the word quit on a line by itself. 
-----BEGIN CERTIFICATE----- 

MIIEZTCCA02gAwIBAgIBAjANBgkqhkiG9w0BAQsFADArMQ4wDAYDVQQKEwVDaXNj 
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bzEZMBcGA1UEAxMQQ2lzY28gUm9vdCBDQSBNMjAeFw0xMjExMTIxMzUwNThaFw0z 
NzExMTIxMzAwMTdaMDYxDjAMBgNVBAoTBUNpc2NvMSQwIgYDVQQDExtDaXNjbyBN 
YW51ZmFjdHVyaW5nIENBIFNIQTIwggEiMA0GCSqGSIb3DQEBAQUAA4IBDwAwggEK 
AoIBAQD0NktCAjJn3kk98hU7wUVp6QlOFrlItEce6CpbfYpeLdUeZduAo+S0otzT 
lJwS2BlMhZtacu9vUpfmW9w7nQo9zVT3eyPuhF/6/9TEdVBn75zb5CfV+E6ld+fH 
nuPiFyBu+HDDJRd373Op+957IdoWyPvD8hHR1HJGFJ3JJKBg0UScL4JCwleu98Xq 
/yPlAqBhExa7a2/fqSmZA0vZIG1bBfWZY8ZtSeTxKg3eWynV+xElabHqTDMYWf+2 
obs4YB5lINTbYgHyRETP6T8Xr6TtD0h3654OUHcW+1meBu/jctluMKppeSjVtrof 
5vt+pbkCg0iQAAjsL0qczT3yaNXvAgMBAAGjggGHMIIBgzAOBgNVHQ8BAf8EBAMC 
AQYwEgYDVR0TAQH/BAgwBgEB/wIBADBcBgNVHSAEVTBTMFEGCisGAQQBCRUBEgAw 
QzBBBggrBgEFBQcCARY1aHR0cDovL3d3dy5jaXNjby5jb20vc2VjdXJpdHkvcGtp 
L3BvbGljaWVzL2luZGV4Lmh0bWwwHQYDVR0OBBYEFHrXeZXKu0gruFUU/aPAD7yn 
D5YZMEEGA1UdHwQ6MDgwNqA0oDKGMGh0dHA6Ly93d3cuY2lzY28uY29tL3NlY3Vy 
aXR5L3BraS9jcmwvY3JjYW0yLmNybDB8BggrBgEFBQcBAQRwMG4wPgYIKwYBBQUH 
MAKGMmh0dHA6Ly93d3cuY2lzY28uY29tL3NlY3VyaXR5L3BraS9jZXJ0cy9jcmNh 
bTIuY2VyMCwGCCsGAQUFBzABhiBodHRwczovL3Rvb2xzLmNpc2NvLmNvbS9wa2kv 
b2NzcDAfBgNVHSMEGDAWgBTJAPkfih/CZr2l0m1lDiIuNMMFoDANBgkqhkiG9w0B 
AQsFAAOCAQEAc1k2rH6YT4juFxs9q7ObzfcKbNvOyDsaU7av4IHFXmn/JxfnBmUv 
YxAI2Hx3xRb0KtG1JGkffQjVAtBboTXynLaQso/jj46ZOubIF8y6Ho3nTAv7Q6VH 
kqSCdZClVu91zbHV9FFYQzJxjw1QgB0a4ItS4yhdmgl3oDNEcb3trQezrQ3/857/ 
ISqBGVLEbKHOu8H6zOLhxAgZ08ae1oQQQJowki0Ibd+LRLGovtEwLg8yyqiTIGve 
7VFL2sRa8Z3rK9tlwKVH2kpFKNAeN3rfKFqr0/weR0cyKpmLMrSBTBZcxQcJCYF4 
X6FO/32KOqcxJFIOKGVIUjvAvioOqoducw== 
-----END CERTIFICATE----- 

Trustpoint 'MIC_trustpoint' is a subordinate CA and holds a non self-signed cert. 
Certificate has the following attributes: 
Fingerprint MD5: AC14F08F C3780F8F D9EEE6C9 39111280 
Fingerprint SHA1: 90B2E06B 7AD5DAFF CFD43187 2909F381 37471BF8 
Trustpoint CA certificate accepted. 
ISR_RA(config)# exit 

• Configure a PKI trustpoint and PKI server to enroll to the CA server. 
ISR_RA# configure terminal 
ISR_RA(config)# crypto pki trustpoint MSCA 
ISR_RA(ca-trustpoint)# enrollment mode ra 
ISR_RA(ca-trustpoint)# enrollment url http://10.81.116.249/certsrv/mscep/mscep.dll 
ISR_RA(ca-trustpoint)# serial-number 
ISR_RA(ca-trustpoint)# fingerprint 81512B4316429092925C6891701B374EBD254447 
ISR_RA(ca-trustpoint)# revocation-check none 
ISR_RA(ca-trustpoint)# rsakeypair MSCA_Key 2048 
ISR_RA(ca-trustpoint)# exit 
ISR_RA(config)# crypto pki server MSCA 
ISR_RA(cs-server)# grant auto trustpointMIC_trustpoint 
ISR_RA(cs-server)# hash sha1 
ISR_RA(cs-server)# mode ra transparent 
ISR_RA(cs-server)# no shutdown 
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Troubleshooting 

Problem Report Tool 

A problem report can be created via the Problem Report Tool in the phone Settings menu. Navigate to Settings > Issues and 
diagnostics > Report problem, enter the information, and press Submit to generate an issue report. 

   

 
The date and time and problem description can be defined. 
The Customer support upload URL option in either Cisco Unified Communications Manager or Broadwork can be configured 
per phone to obtain the logs automatically or manually download the logs from the phone’s webpage. 
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Wi-Fi statistics 

Navigate to Settings > Issues and diagnostics > Diagnostics > Device status > Wireless statistics. 

 

View Streaming Statistics 

The Cisco Desk Phone 9800 Series provides call statistic information, where codec type, jitter and packet count info, etc. is 
displayed. 
Visit your phone’s IP address in a web browser and view the streaming statistics. 
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Wi-Fi Signal Indicator 

On the Home screen of your phone, Wi-Fi signal is displayed on top-right corner when connected with AP. 

 

View the Information About the Connected Access Point 

Navigate to Settings > Network connection > Wi-Fi, select the connected AP, and choose Advanced Wi-Fi details. 

     

Note: When user encounters Wi-Fi problem, please check the connected AP status, AP parameters, phone side signal strength 
and phone Wi-Fi statistics.  If the configurations are correct and the desired AP is healthy, toggle Wi-Fi off and on via the 
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phone menu could help to recover Wi-Fi connection.  If this doesn’t work, plug-in the wired cable and generate PRT in the 
phone menu. 

Capture a Screenshot of the Phone Display 

For phones that are registered to Webex Calling or BroadWorks, get the IP address of your phone and vist  
http://<phone_IP_address>/admin/screendump.bmp in a web browser. For exmaple, 
http://192.168.16.43/admin/screendump.bmp.  When prompted, enter the password for the admin. 

For phones that are registered to Cisco Unified Communications Manager, get the IP address of your phoen and 
http://<phone_IP_address>/CGI/Screenshot. For example, http192.168.32.124/CGI/Screenshot .When prompted, enter the 
username and password for the account that your phone is associated with in Cisco Unified Communications Manager. 

Capture Packets 

For phones that are registered to Webex Calling or BroadWorks, you can capture the packets by visiting 
http://<phone_IP_address>/admin in a web browser.  

1. Navigate to Info > Debug Info and clicke Start Packet Capture. 

 

2. Click Submit in the prompt. 

 

3. When the process completes, click Stop Packet Capture to stop capturing. 

 

The captured file is available for downloading. 

  

http://192.168.16.43/admin/screendump.bmp
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Additional Documentation 

Cisco Desk Phone 9800 Series Datasheet: https://www.cisco.com/c/en/us/products/collateral/collaboration-endpoints/ip-
phones/desk-phone-9800-series-ds.html 

Cisco Desk Phone 9800 Series User and Administrator Documentation: https://cisco.com/go/dp9800help 

 

Other Documentation for Reference 

http://www.cisco.com/c/en/us/td/docs/wireless/access_point/12-4-25d-JA/Configuration/guide/cg_12_4_25d_JA.html 

http://www.cisco.com/c/en/us/support/docs/security-vpn/public-key-infrastructure-pki/116167-technote-scep-00.html 

http://www.cisco.com/c/en/us/td/docs/routers/connectedgrid/cgr1000/1_0/software/configuration/guide/certificates/CertsGuide
_cgr1000.html#wp1000815 

http://www.cisco.com/c/en/us/support/docs/security/identity-services-engine-software/116068-configure-product-
00.html#anc14 

https://technet.microsoft.com/en-us/library/cc731183.aspx 

https://technet.microsoft.com/en-us/library/cc772192.aspx 

https://technet.microsoft.com/en-us/library/hh831498.aspx 

https://technet.microsoft.com/en-us/library/cc772393%28v=ws.10%29.aspx#BKMK_BS2 

http://social.technet.microsoft.com/wiki/contents/articles/9063.network-device-enrollment-service-ndes-in-active-directory-
certificate-services-ad-cs.aspx 

http://www.cisco.com/c/en/us/td/docs/ios-xml/ios/sec_conn_pki/configuration/xe-3s/sec-pki-xe-3s-book/sec-cfg-auth-rev-
cert.html#GUID-4A2D2A66-F6FB-4FD1-AD40-B7D73531468E 

http://www.cisco.com/c/en/us/td/docs/ios/12_2/security/configuration/guide/fsecur_c/scfrad.html#wp1001000 
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